A P A R I R AT T

TEEERNTA

TEFRZE AR PRSI ER: ik (Address) « #5 (SymboD) , Wikt
(Monitor Format) , Wi¥i{E (Monitor Value) & (Modify Value)

Iy‘"\ul"al (@ Variable Table 1

JIable  Edit Insert Variable View Options Window Help

| Dlsla] & a(olelol|¥ @ v
ofele ) wl [EEE LD sEE e

¥4 @ "Variable Table 1" —znm_nz_sml?_awuqmmxm:m -|of x|

4| Address | Symb Display Format |Status Val [Force Valu| -
/OB 1 Network 1

01 “Pushbutton 1" BOOL
0.2 “Pushbutton 2" BOOL
4.0 “Green light" BOOL
OB1 Network 3
05 “Automatic On" BOOL
0.6 “Manual On" BOOL
42 “Automatic mode” BOOL
"PE_on” BOOL
11 "PE_off" BOOL
1.2 ."PE_[ail;.lf' BOOL
51 "PE_preset_reached” BOOL
5.0 "PE_on" BOOL
OB1 call FB1 for diesel engine on

14 “"DE_on" BOOL
15 "DE_off’ BOOL

MPI = 3 (direct)

ATHEAFSHIER
o XIFFEBEMA R AN ST S, R B 4TS AT S, AT LAE “Huk”

A BRI H AZV S AN ERRA S WA N RS CAERF SR e 3G )
PSR IER 2 AN

BN B 5 R 8 UL A5
o SIS RTS R P E LRI o
o FFEALPEHERT MBS SRR (Flw, “Motor.off” , “Motor+Off” ,
“Motor-off” ) .

o WIERFSERPENHGS, Al 44 Options > Symbol Table, ]IS
TG HIFF RGN B2 B R,
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BHERE

B KPR

20.4.2

20.4.3

FEAZ RPN RN, fERHAT NGRS PAT AR B . AT AN IER A SR N
2Lt WEARKOUATRAELL AT B ATELE R R R $2F T A3 S50 T AR A IR 6
No

TR BT AN SR 388 B 3%, VIR AE“ Brief Information When Using the Keyboard”
(55 FH A8 s T A R R

RS EL, AT DL S A 4 Option>Customize s iR B R I &, SRFiLHE “General”
FREEAE,

E R PR TRS W H 26715 MIEENE ZATREATREN . — M aEREH
102447, X i KRR

T ERPHEA—NELAHUER

TP MR,

K ehrdi Mok 2 IR B, Ak 4 N T 2 (0 ik Y
WP dr 4 Insert > Range of Variables. LI ¥ HIBL “ 46 AZS AT 7 SHGHE .
7t “From Address” =t Nl af k.

7E “Number” ¥ 5% NN\ Z4d A I £

MRV B PRI (¥ s 2

. BT “OK” %L

JEI AR R R EEHA L AN L &,

N o o b~ WwN -

mAZE

EMEIENER

R EACE B SUE T TRk, W LU ISR 4 4 Variable > Modify Value as
Comment, —MERMBEAALZAIINERATS “/ 7 ZoRnECaL. TGS “I1 7
e “BEUE” AT, R nr AR ey & o I A S LAy 4 Variable >
Modify Value as Comment silHERERAT S, TRUBGH “Eodl” fsdt.
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20.4.4 EBTEEREMNEI LR

R, THZERAN 21 R
Br: W#16#3999 (BCDHE I 1) 45 KA

245
ki I Uk 5 BN | ERERT i
T1 SIMATIC_TIME 137 | SETIME#130MS ity =R
MW4 | SIMATIC_TIME 137 | SETIME#890MS A HBCDH# ik
MW4 | HEX 137 | W#16#0089 A FIBCDH# A FKIA
MW6 | HEX 157 | W#16#009D lﬁig%ﬁ%ﬁﬁE PRl B A AR

o TTLUME RN E I ], (R AL S AE — Lo 508 LU W R 2o R R A% U R
NSRS SRR RIS AT 3 (13748/8130ms, 7ms#iar2) .

o W E N EHET EWORDIAS R, WIWT, B HBCDM . (HiE, AEFa RN
B #B A 2KIBCDIG o 4p Js— AN HE 2R A EWORD AL & % 3& A SIMATIC-TIME, U
R FTEIE 4 A G4 B GXHLRE: HEX, A B GBI ML L, B4 (“view”
MERD D, EFEEE T LI R T

HFSIMATIC-TIME#& X - 2 #yBCD%3
{EHIZEIN SIMATIC_TIMEM AR R A SE N ZHIBCDI . 16 B LU 7 X

[00xx|hhhh|tttt|uuuu]
fE16HI14  BEE
P32 Chaaxx) AALOA N1 5EE Tkl
00=>FRH 10
01=>A 1 100=F
10=>% 4 175
M=>FHCH 107
1128 R E . (hhhh)
L7401 (ttt)
FE3F0N ML Cuuuu)

20.4.5 TEBWAR LR

R T B N R
THEER A R C#999
W#16#0999 (BCDH# 2\ A& KA
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5140

ik BEAAE HIA ERERT i

C1 COUNTER | 137 C#137 L

MW4 COUNTER | 137 C#89 A JHBCD#% R Kik

MW4 HEX 137 W#16#0089 ] HIBCDH#S R &k

AALAFIA NBCDIS R, Ak
MW6 HEX 157 Wi#16#009D COUNTERK 5t bt
=

o IR THEER AN A T REREUR N BAT AR RATCH, XAME 2 B3 ABCD%
(13748 JC#137) .

o IHETCEE A EWORDRIAS B, WIW, ks BCDI{ K. (HAE, AZEFrH
PR A MBCDIS . iR, HEIEHWORDIM A FAE ikFRik H COUNTER,
U7 FHRE 7 4 1 Sl 1) 0 4 s o G - HEX, Tl B B IR X, Be4s 4 (view
MR D, XFEEUEHE T AR BoR T .

20.4.6 ENERIT
VERATLGRZE </ 7 TFG.

WU Al ATRE AT AR RN (A MERAT) , 1T B2 47 4 Edit > Row not
Effect s TILRH N7 5 [X]

20.4.7 =45

20.4.7.1 HETEXRPHAHUTRSG)

b0y a0kl R LA, 25 (SHERNIEF:

Input | Output | Bit memory BOOL 1.0 |Q17| M104
Input | Output | Bit memory BYTE IB1 |QB10| MB 100
Input | Output | Bit memory WORD W1 |QW 10| MW 100
Input | Output | Bit memory DWORD ID1 |QD 10| MD 100
I/0  (Input | Output) BYTE PBO |PQB 1

/0 (Input | Output) WORD PIWO | PQW 1

/0 (Input | Output) DWORD PIDO |PQD 1
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SRR HRER. ) (EEBHEFD:
Timers TIMER T1
Counters COUNTER C1
Data block BOOL DB1.DBX 1.0
Data block BYTE DB1.DBB 1
Data block WORD DB1.DBW 1
Data block DWORD DB1.DBD 1

=
=

“DBO...” ARVFEM, BIOVECHARS .

EREHETA:
o XS7-300BIRHEAT IR BN, NN FHAO Gl Z&rrelr.
o XIS7-A00MEMAERRHIIT, HARA il MAERERO GRSt JETTLA .

20.4.7.2 i NEEHHESEE B RG)

FIT—AZ LI LA a4 Insert > Range of Variables i/l “Insert Range of
Variables CGEAZRIEED 7 X IHHE.

VEAXTRHERIZE H, N ASATER GO A7 X i A B AL B e

o From address (JF&RHill) : M 3.0

e Number (F&) : 10

e Display format (g% : BIN

ek BRER
M 3.0 BIN
M 3.1 BIN
M 3.2 BIN
M 3.3 BIN
M 3.4 BIN
M 3.5 BIN
M 3.6 BIN
M 3.7 BIN
M 4.0 BIN
M 4.1 BIN

TER R “ k" A SR\ AT UG 715 ik 2
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20.4.7.3

ksl

Fivihit

Fiik

T F ok

N B FASE I E A 7R B

AT BERY A1t SVFE /SR HE
[1.0 true
M1.7 false
Q10.7 0
DB1.DBX1.1 1
111 2#0
M1.6 2#1
AJRERYF TR AE SRVFHEBY/EHE
B 1 2#00110011
MB 12 B#16#1F
MB 14 1F
QB 10 ‘a’
DB1.DBB 1 10
PQB 2 -12
A Y Ak SVFE /SR HE
IW 1 2#0011001100110011
MW 12 w#16#ABCD
MW 14 ABCD
QW 10 B#(12,34)
DB1.DBW 1 ‘ab’
PQW 2 -12345
MW3 12345
MW5 sbt#12s340ms
MW7 0.3s0r0,3s
MW9 c#123
MW11 d#1990-12-31
A HE R e ik RVFEB/ETHE
ID1 2#00110011001100110011001100110011
MD 0 23e4
MD 4 2
QD 10 dw#16#abcdef10
QDb 12 ABCDEF10
DB1.DBD 1 b#(12,34,56,78)
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E RS 2R

TR

A BERI X F bt RIFIEH/ARTIE

PQD 2 ‘abcd’

MD 8 |#-12

MD 12 1#12

MD 16 -123456789

MD 20 123456789

MD 24 t#12s345ms

MD 28 tod#1:2:34.567

MD 32 p#e0.0

ATHERY “Timer” ZEEUbht RIVFIER/ARTIE TR

T 0 el D
T12 20 =R
T14 12345 ey 2 b
T16 sbt#12s340ms

T18 3 #:1s300ms
T20 3s % J31s300ms

B oiese i o R A AR R RS . X IRAE I B T B RME i) B 2, HEIAR S
AN TIHEEERESE R,
ONTF 5t sbtime, AXA4YKANE,

ATBERY “Counter” ZEEIiitit RIFIEL/ARSIE
C1 0
C14 20
C16 c#123
&S Has Hosg ) HAE A W RS . XERE i EES CII B E B o &, A4S

By

A CTHIZAREAES R .

20.5 EI5 CPU ByEZE

BIRTELIEIE

20-10

AT BB SRR (VAT PR AR R, A AN (K CPURE &L . ) LUR AR
At S AN A CPURE . B % .

WERAEEGERAPAE, ATRRE AR AP “ONLINE (e 7 Il BoRizthil. R
PR R BRAERA “RUN” . “STOP” . “DISCONNECTED” & “CONNECTED” , iX
e F-CPU.
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B 5CPULELEE
WS TR CPUBA @ T AE LR, M4 PLC > Connect To > k& X5
P CPURIZERE, LU HEAT 4R 5 i I AN 308 4

i 5 CPURYTEL: i 3
i 325454 PLC > Disconnect, #] LA iAs & FICPUK) %12

iR
WIS Hdr 9 Table > New, BT —RaTAHIARRR, R BINERDIRE AR
CPULE (ERRFHIAERFGE -

20.6 MHUTE
20.6.1 MMTENE

A CA R 7 i s AR A

o HIZEH4r4 Variable > Monitor, W& MARLIAE . 7178 5 1B AR i B0 1 o0
Fful AR BRAEAR R . R B AR AR N “Every Cycle CRE—REHD ~, wJ
LAHISE i 2-Variable > Monitor, K IR i D)4 s IC 3

o T LUM¥ HI 3K ér 4 Variable > Update Monitor Values, %37 12648 2 (1 5 {H 1 — vk 7 B
FHT o TR AR o 1) 2 R ) R AR AR R

FIESCHERIFT “Hsil”
U RAE WAL D REOE FPIRAS N IZESCHE, XD Re ALy il il

20.6.2 WETSERUIEfA

Al ATE SR b ks F P R e th AN AR BEAE AR e AR B R rh 3 — R i (A D 102
BPEUE, DM e AT AL

R AR S, R T A AR SR IR A B R A B A B R
A LI SE idy 4 Variable > Trigger, % B fil & s il & 4505
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i & Al BEHTIRE
itk A 55 EREiBaN
ESEitaTN
MRUNE#:2STOP
i R AR —
AR
L=y
T B il S E
b B N
+7 filJz 5 “Start of cycle (JEHITER) 7
S I I
i
OB1 1"‘\ fih % £ “Transition
- ] from RUN to STOP
CNBATE I EHLD 7
+— fih % 55 “Start of cycle (fEHITAR) 7
IR S
1F “Status Value” #4H B B MUE, K MALRI it & S B EAE “Start of cycle” , BB
fib R S EAE “End of cycle” .
STRNfl A&
A] U328 fir 4 Variable > Update Monitor Values, Wl ATikas & HHUE . XA a4 1)
Qg TR, AR PR R A, R T RER AT . X RE ] T CPUAL
FAEHIBT R R B
fiih A2 S 2R
FERER T ko IR A WA 5
A SRR —K AR §—N 3
WA R | AR AR S BEE, Hh | AR e SR s IR
K IR ANHIRE, T DAV A M A o R
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20.7 BHZT=

3

HelD

20.7.1 BZTENNE

A LUR R R T VAT AR WA L

o JUZH A4 Variable > ModifyBuf & i ohfie. AR, MUl A mORI i 5 A% 1)
T TR T 678 B AR (R B EAE SO N F B P AR b e SR B AR SR “ Every
Cycle (&:—43#) 7, WTLAHsEHdy4Variable > Modify, KWL IhBEDI R IC L

o HISZ¥ifiy4Variable > Activate Modify Values, ¥ TiE2s & (KB AE — R RIRIHT .
SR THRER M AE AN B (PQ) $R 4t — e B T BRI AT AE .

BTSSR EE T EAIIER :
o HUREXIAEAR B ] U B M A T 45 250
WG/ R TR, A7 2B OB ST M A REE B kAR R
CIEVES %/ UG 2 Rate S TR g1
o IR RPESIUATEGY (L, HEdit>Undo) .

BT eSS Al R DR e nT A S 8O AN S B P B EE . R PAT
“NEoi” ThEewr, AN H GG,

FIESCHMF “fge”
WRAE “Modifying (B0 7 DheEAT LR AEHIESCHE, X DhRETC IR i .

20.7.2 RETERMAINGE

Al AFERR B AT R IO — AN S 25 (b A 45 T P RE R b 28 B 61 S8 A (IRl
— D

e MR S, B E T R AR B R I I ) TR A o R
Al LU 3E i fr 4 Variable > Trigger, $08 filt & s5UR i & 4%

il FIRERIRE

kR ESEPIR
EEEHEETY
MIBATHE 9 (AL

i A —iK
IV CEE 1]
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A =

SIRNfR A

A SRR

20-14

B s b il m AL

TR G AN
*7 filh % 55 “Start of cycle (FHHIT4R)
Ll i\
fil % 55 “Transition
OB1 1™ from RUN to STOP
- - CNIZF IR L) 7

fii% 55 “Start of cycle (FAHITEE) 7

PR L]

FER ok s vy

o Bk N KIS bk s “Start of cycle”  Cif TR P RERFOBTIITUR)  BINLER
BOERSTE PRl PN

o B HAEH T & S “End of cycle” (RN T HI S RERFOBIIZ ) , FHIA
TR ¥ o FR R i R X

1 “Status Value” #r Bor B, LM lR S ETE “Start of cycle” , #HEEUN

fil & M EALE “End of cycle”

AR RAE SN, R A OLIE AR fid R A

o WIRAEAFEREN “Once” , MTEEREAGEHE GBS, SERER.

o WURAbE AR E A “Every cycle” WIS B HL.

A] LU IS # dir 4 Variable > Activate Modify Values, % k2 & HUEIIT B, X
A AR SRR 7 ASSHT PR AT S, AT AR AT . XA TR 2
TAECPUENIR A M Bk

RIS AR 1K) B E R A AR U R -

PRI —IK fRASNE. §—XFHEN
Pt Sk s | AR AR REAT BT
feecet | 0K, TRUKBUEIRGT AR | i T R, AT U P R R
T/ FIXANThREw] I 4 4 (R D e
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20.8 EEHIT=E

20.8.1 EHITERHIREIEIE

>

EBEARGERVFERE
VERL, A “omik)” ThEem, ARfTAS IR R T RE L
o JE XN EAERE, B
o EMRBIAEEEAT) A

A\

NI
A o TETTURHREIT) fe 2 26200 2 i O [l — IS R 7E ] — CPU L3 A HA A AR AT %) fe

— ARV L BE IS B Ay A-Variable > Stop ForcingsMMBRER L 1F. e smBIEuE &
HEgE Y “Monitoring and Modifying Variables” S 2 FEASBEM G S I 4E L .

o SRHITHAEAREMEGE (Fldn, HIEdit> Undo) .

o BB MERE, TS S 0] 1 2 .

o WUIR—ACPUASZHERRHIT)AE, WIFEAR &5 i rh By i hilog O 0 T 3 i 2 #A Rl
o

3K Hidy 4 Variable > Enable Peripheral Output, %28 %0, BT sl amiii

i R RBEAS i e AT SR AR

20.8.2 EHITEHINDE

Al LA P R IR AR R R T e, B CPUH IEZEBAT (9 F P AR 7 B A B8 iR
BRI Tl . SePLX — D REME K R CPUSCH %I RE (dn, S7-400/ICPU) . it
B e RS AR B IX —ThhE, W A P R BB R T IS T T 7 250 Cgm R M Th g
HEAT IR

“oR%I|#E (ForceValues) ” HO
SV sl BUE” AR THOEIRAS, A RRER A TomBIm S a4 .
B R oRIXAN B O S i dr4-Variable > Display Force Values.
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FECPUHTIT—A> “oil e &, Fembl A S A Eq 1% B bl E i Sos7ed .

BT EEE ORI
2 Force Values : MPI = 3 (direct) ONLINE =]
2 | Address | Symbol | Display Format | Force Value
of 'ﬁ' B 0 HEX B&#16#10
E Fla o1 BOOL true
3 Fla 1z BOOL true
4

RIS A T R fERRREAZ

RZSEE AR IZ WCPUBE i Ry s AR PR IR Th) o
UERBAT BeE R, T A

£ “omflEE” PR EA R MR RIEA R S

T & X

Ak AL CPUM LU T 1

E% AR £ AT

Wit BRI AR LR 1A {7 AL N oot A R B, sl

fF AT E R ARG At
WERAE AR R O N RR PR AR, ERRERANTFEWA R, RETRAZE
Hifir4Variable > Force values$] 5 il {E & 11 o 44 AT A5 il i 4% 4 O\ B3 i (5 % 1
{8 FI CPU 9 Y58 1l 45 i 33U X2 A sl 1l
WA “sRBIEE” & DRI BROE, WA S AMNE R R
o WIRHIN, ZE O PSR SR CPUR SR EL B 5. FI Sk fdr 2 Edit >
Undo, W LA T — % H I A 7
o WUREUH, UYETE O N AR E TR,
RG] UL iy 4 Table > Save As, 4 “SRifIEUE” & OMWARGF I —MERE,

HH L FE L2 Variable > Force: IXFEAURE 4 i 11K A 225 BICPU R — AN
LG (R

AT MERAME SO BEAE AR R R AT, ANBEAE “RiIEUE” E
I BR 325 5018

32 86 4 Variable > Display Force ValuesiT FFiIBUE R 1. SRJ5 844
Variable > Delete Force M 7% it CPU H 5 5 il

FiEERHER D

LUK SR B B D RN AR R AR R . [EHISE L dr & Insert > Variable Table,
AT LATE— AN s R e 1 oh TR N A A2
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ERFBETORXTHSHRT

BrAE AL EIBA TS N IR AT T “ A S &7 MR, 5 W i s 1)

B R 07 S 2

WARTGERMALT 54, W “Symbol (£55) 7”7
Option > Symlol Table®¥ i .

R T XSO, S

20.8.3 EFIFEHTERIX A
TEREGE T SRS SR X
45 5 /ThRE S7-400( &1 #§ CPU | S7-300(F&1#ECPU | 18
318-2DP)s&#IThaE | 318-2DP)3EFIThAE
PAEE (M) Yes Yes
SE I SR HEHT. C) - Yes
HiiH4(DB) i Yes
S (PIB. PIW, PID) Yes
& (PQB. PQW. PQD) Yes Yes
ENFE (L Q) Yes Yes Yes
FH P2 ] 7 5 16 o e Yes Yes
6 R i s A5 Yes Yes
N FH R PR H AR AT R R LA Yes Yes
L CPURBERMITT J5 B AT R FEH A4 | Yes Yes
PV T HE AR o
W W SRR T ﬁﬁﬁ&%ﬁﬁﬂ
W1 Esy/smEE: o0
WE iR RS ST R A2 7 B i R/ x 2 €Sk
ki
e RS R TR IR AR | ST e AR Yes

==
b5 =N

o “AEREAMBLHMIL” I, AEAH N AR A

HAE AL

o fEFHIRBITHAE, ARE LA

e Hh AR A EUEA RG uAh B H R

HEI, BT A SRS B LA
o WETACIESONAEIT, ORI AR T R TR

A IR IR IXEEHAE T DLAE P R A BT 1R 1 R
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21

/N

MIRXFE P RS

i WoRTERIRE (RLO, RS BN BF4AR A BImAH MY A48 N A 1 7 o R e kAT
Wik . 7T LLLE “ Customize” XJ i AE #  XAE “LAD/FBD” i [ 77 (1 & /= Ye [« 76
“LAD/STL/FBD: Programming Blocks” % 01, 1832 #.1ir4Options > Customize}]
FRXAKHEHE .

3
il

FER AT I INARE Y, I ThREsR e th s, 20 A B B 7 3 ™ FE A 5
LETTAEIMAII R B, A A TG IE O

BRREFIRES, AL AL T R
o HEBCHETRIAEY, JFH FEEFICPU,
o CPUBATIF HH R AT -

BMEFRTEHERSRE

SR VAN EE PR RE P REA TP, T — NPt A O S e A% M T =
IRE T ERANZ PTG, Blin, EOBTHHA e, ik RS otz i o) e A sl ik i)
g,

| TELAT TS
v
| %E?%f%%ﬁ% |

| A R |

FESCRFIAES Carig)

v

JA Bh/5% I

VR WA, PR T HATIER, D E MR R (3K 44 Debug >
Operation) . XLEPATHRELE LT FRERMER T AT REN



WAL IR

21.1 BEBFRKREET

ARSI 2 AR o APTIEFEHIRE - BOT 4R -

#LADFAFBD%#48 38 Fh R TR 27 & (XA
o CIRAAL: SO

o CIREAWL: HEANL
o CIREARG: RS

1E “LAD/FBD” #5325, {fi T3¢ Hi4y4-Options > Customize, 1] AR L: R K it i TS

TERIRTS
o il S KPR AR 1
- WRAZHAE AT 17 I .
- WAZHE AT 07 (AN AL .
- D SR Ak B AN R TE D A AR
ol AMERERT (ENOD FIICECIRANS M- LAENO%ay i {E h ubik (s s AR A o
o ity QffittH A TCFORANS I T2 Ik B A Ak RS
o WIRBRA/EIHIIREGHECE AL, WIIHA] (CALL) HPIRZWHAL .
o WURBEHAAT B RS FPRE L, BIE ARG AT AL -
o irAIflifERIE (ENOD [ICE, WERAEREH i RFOERENIZITER B h B .

KAV
o LRIPIRASWUER AR BB AT 58 4B AT M2 PR .
o TEREVITARALZ MRS BRIALIT € “17 )
o JHMT SO L RPIRA B2 C“17 ) .
o QSRS TUE R T TR 2k FRODR 285 A8 A U 2% 7 3% J T PR 2 FRODR 83 A o
o WIRNOTHRA I L HPREAW L (D WINOTHEA i i 2R A AL -
o fENFIGOLN, VF2 LA U A EAR A TT LA AL -
- HZ R R SR MRS AL -
- O SRR PR AL -

o BIREBMSHAE L.
o MRS EALR A RT— N IR XA R R TRl A B



WAL PR

21.2 HEBELEN/M S THITIRE TRNER

RN AT, T LU T i
o HIESAAR A MMITRT (BB HET)
o BRI

“HEBRIR IR B0 R EHT A T G R bl 5 RSl (B AIX T
BRIV

| stawswoa &

[FC STA 0S Cco BR
I: |_
RLO OR ov CC1

Accul 3039 Accu2 58
AR1 0 AR2 84000000
ShdDB InstDB

=K
o DA AT R . B BT SR N R AN TR (LR F A &
Debug > Operation) -
o SATMEHISTLG R, A AT L] b AT B AR LADERFBD AL ey b, 425
FHzE a4 View > STLE AR A STLY FEHE =
o ZUUAREBORY .
o PUBITELAT T
o CITIFMICARRETE gt 25 h AT B 2
iF=N=
W7 S EE AR S A B AR
o CCEMIMT AR
o BHAREBITHEH
o FPIRBIBITIEHE
S YRR R VR, AH 2 SR D PUT R
71 “Debug CIHRD ~ Zgiirh, AILMRBIER G RS WURSMBRET s, ey AR
AR P R PO LS A A, IS firS View > Breakpoint Bar ] LG R sS4,
SVFRTMIR Th
o IRM/EHIL R



WAL IR

o HERATE
o HRAFREK

&% (Danger)
fEHOLD (fRFF) Bl M RGN .

21.3 7 HOLD (¥ BNz THRAER

UIERRE BRI, TGRS % HE AHOLD# A A 5

HOLD# = TLEDBYE R
e LED RUN A%
e LED STOP =

#EHOLDH#A THZF A0447
o #EHOLDHIR FAMRBISTHE 41, SRR B RSCMEIL —HAL T,
o DA BB
- AIFUERSEI 5978
- BEAT B T 1
- TR A N B
o SNBSS
o AR, fEHOLDHIR Pt MR IEI C “Hubtik” )

HOLD#E T iRz i R Ry 1 BE
o BT A I K ] i RE P A AEHOLDRE U, A8 HUUT B I W 2 I K 2t ASTOPH X
HARFFAESTOPKI . CPUARAT AN 2 (B85 8h) . 7ESTOPAEA T AJ LAy sE ik e
frgks (it BWEAGREIR, PAT—ADTFrEsh .
o WA A H AR TR RIS A A “agie” ThRg, PR HERE S RAT N BB
Wi sl AN RS LA R AR R

21.4  HIERBVIRTS

JRABLL ERISTEP 7#8m] LALER 0 A b /e St i e o s Dh RE AT LA i 72 e Bt et
AT LA B e B D o AP DL, AT DL s W] g R s o s e A



WAL PR

TERBIRE RS T, AR S . WAL S M e Hl B2 AT S5 2257 (7%
1D AT UM i Sf 8 e i e B4R 0 m] g R Pl o

B e 007 T “data view (Bl e 7 o, DUEAEZAE AT LLE 7R 7E “Actual Value
CSEBREED 7 FErh e A 7R 57 Al U S PR A i o A RER B . AR AR I
ABEVIHN WAL o

FEHHIE R, AR R Bos — A aRHE, JF Bos i ERia.

B B A BRI R, SR AR

TESATLIRASIE, “Actual Value CSBREUID 7 RAK SRR Z B2 26,
REAS TR (0 1 B | 55 B R

BEHEELE.
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I IF) i OB 80
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AR SR MFIER, e T 2RI OB 2 RE7E 1% CPU_EHIT .
FEFRIFI “Block (B 7 SCpEerhifi NIF4T I 1Z0BEL.
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23.9.1  iFEESERET_VAL

RGUIREMN S HRET_VAL GRIFME) fir7nCPURE M IEMM AT T SFCLIfE .
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fEXTREE
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AT Y SR IR
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o RGRRIFIATH KR
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AL OB 82 TR
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CPURE et OB 84
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HFEOB811% 44451
fFHFHROBARIEIE OUaahfEE) , ArRUAIK C B A R AR,
B, dnSECPUKIN B — /N ik, #/ERSENRAOB8T (KD .

. OBB1 Kl CL % th I b

I I AR R 1 S LTt il
i f— OB 81 Rt 3 1 11

T g 4 21 HbEHRT (CPU !
BERS | RIERT ) s (oPUY T
23 24V Hj§HER (cPU) Y
31 WEEHRT R
32 E&MHE Igpt)
33 24VHLEHE (P Y

1 A&EHITS7-300

T LA AR AR RE th OB8T IR i ftt 5 () 2 1A s ot T LA 5 R P 1 L i B2,
WS PR AE ol L s T A S

HFEOBS 1 HY FigE1E
TR N AEOBS K I AR i 5 WA R b HEAT A A IR I R R B3R R .
7% “Battery error (BOOL) 7 W ZigAniifE ot (i, Q4.0) , XAFFEF e #8
43R BENS U7 ) 1% BE 5 T

AR & W R R
TEMP OB81EVCLASS BYTE R 5 139X
TEMP OBS81FLTID BYTE SRR

b#16#21 = CPUFFZ AT M it e 7V
b#16#22 = 7ECPUT L& HIJE

b#16#23 = CPU124-Vi i

b#16#31 = 2/DFH MY RIS B —A 50
Rt T

b#16#32 = 7E—ANY RN LA B k"
b#16#33 = — N RHLZE24V Y h

TEMP OB81PRIORITY BYTE Lo 2=26/28
TEMP OB81OBNUMBR BYTE 81 = 0OB81
TEMP OB81RESERVED1 BYTE TR

TEMP OB81RESERVED2 BYTE R

TEMP OB81MDLADDR INT TR
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L & W % ik
TEMP OB81RESERVEDS BYTE H5HRISB#16#31, B#16#32, B#16#334H
%
TEMP OB81RESERVED4 BYTE
TEMP OB81RESERVEDbS BYTE
TEMP OB81RESERVEDG BYTE
TEMP OB81DATETIME DATEAND FA OB H YT A]
TIME

1) =ANEH$57-300
K OBB1 72 72

(ESTLR A1 b 49 7 7 £ OBB1 el 4L,

EEZAET

o  OBS1H 4 R/LHE (OB81 FLTID) #fitt H55i¢k: “ s ”

HUHAFLE

(B#16#3921) 1

o IR S “ (battery exhausted) HLiB%cHL” FIACHD, FERENIBkSIbR S b Berr
HIFi A B0 H batteryerror .

o IIHERARITE “ (battery exhausted) HLIB¥EHL” MACIEAST, B2 NP4 RACID
5 bl ARRSE A .

o WIREFRAMATE b pE” A, RFBRESRS “Berr” , JEEUE M

“batteryerror” .

AWL
B#16#21

—

L #0OB81_FLT_ID

T NWHZERES A o

15t AR

I PGS “ b
/I (B#16#21)

/I 5OB81HIH R,

I ERARTE CREAEEE)
/I Bk zIBerr.

JC Berr

L B#16#22 I PR AT« it i
/I (b#16#22)

—= /1 5 0B8R

JC BF I WERAHIE, B3 Berr.

BEU /I T B R A R

Berr: L  B#16#39 I 5 —FFIDIAT LU

L #0B81_EV_CLASS

S batteryerror

/1 OB81HA AR
A1 S e b e R A LR B

I BRI “battery error” .
I (FF5RAZE)
L B#16#38 /I ERID, LlfE OBS81

I RAR A
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R batteryerror I AT “battery error” , 23R E I .

LEAHRE (¥ H 5 By b v] A4 5COBL SFB. SFCIUTE PRGN A5 B LA K SH0F I DA RE o

23.9.3 AMFEIZEIBABKRE

Sof TR S (R, SRR I NS 5, nT DA T i e R B

A AEANL . WTH LI BRI A -

o JASTEP 74 mI 2075 % AR A O AR . TCV2EA5 BURAE 2 500 4 HH AR e B4R
{10,

e JHSFCA44 RPLVAL, #JLA{E#EOB 4w S B 0E UE M T A

XTI SR FEP AR R (AR 2, T LIRS OB S s W &R & — MEUH.

BREEEFEG
ELUF R IRE P, #ESFC44 RPLVALH A — AN EAUE. NG T CPUE M4
S B — A NS B S R FH OB 12210

OB1
TG
\ 0B 122 SFC44
~ RPL_VAL
FERXA TR, T PR EAEAE RPN, IXPERE Rt ol LU AT (S 4k 4

1o

i 0001 0010

Start_Sw 10.0
Stop_Sw 101

Stand_Eval 10.3
Full_ Sw 104

BRI ARG W, PATHRAL PIBOSL & ™ A — AN B R IF ) 0B122. A ks
e, XAREEIR AR EUE0. SR, HISFCA4, mILICH IR & AT A& MfE. SFCHIR
SE MIRFAE R e R A A A

LUN - BRI 5 7E0B 122 . N R Fs A /EOB122 A & 75 W] & vh 75 B I In A2 & (g
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Aerr:

Stop:

AR 2 e/l A
TEMP | OB122EVCLASS BYTE HER G /S 151 D29xx
Y A
TEMP | OB122SWFLT BYTE IR N 5
16442, 16443, 16#44 ", 16#45
TEMP | OB122PRIORITY BYTE 54 =4 B OB ARt S 2
TEMP | OB1220BNUMBR | BYTE 122 = OB122
TEMP | OB122BLKTYPE BYTE AR LI e () 24 28
TEMP | OB122MEMAREA | BYTE AT Al X kA i) A 780
TEMP | OB122MEMADDR | WORD L R Ak Bt
TEMP OB122BLKNUM WORD VB BB )50
TEMP | OB122PRGADDR | WORD A G4 (AR T L
TEMP | OB122DATETIME | DATEANDTIME | Ja OB H #IFI S )
TEMP | 45 INT FEG#ESFCAA P HE ALY
1) AiEMFS7-300
STL 3B
L B#16#2942 g NI/ ORS LI )8 58, B OB 122 S -1 5 Fi4EhY
#OB122SWFLT  (B#16#2942) ik, B —HEkF “Aerr”
==| H U (r— DMIAFERBERAE SR ¥0B1221di X
JC  Aerr S5 FRY (B#16#2943) 1ELLE:. Wik —FEBks] “STOP”

L B#16#2943
<> |

JC Stop

CALL "REPL_VAL"
VAL :
RETVAL : = #Error
L #Erro

L 0

==|

BEC

CALL “STP"

e “Aerr” + F5DWH#H16#2912 (—iE4110010) 451%£%ISFC44
(REPL_VAL) . SFC 44K Z A28 3 2 na1 CFhoB122
WM R B o SFCIAN RS EfE A #E rror.

= DW#16#2912 F#Error 50 (U A1 [ OB 122 AT I BV«

WERBAT R AR

“Stop” t5'5: MHAISFC46 “STP” ,
HCPUHL ySTOPHE .

“Stop” t5'5: PHISFC46 “STP” ,
HCPUH STOPEL.
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23.9.4 I/OTLREEIR (OB70)

15 BF
XHFH CPUIKHERME R4S, M RPROFIBUS DP_EMELITA FSL (4, DPIFuh sk DP
S OB M), Bk, S /O DP M 2SR (IDP = uk N, RS
OB70.

EOB70H 4RIz

DAAEFSTEP 748 P R A il —ANOB70. 82 i B 4 'S EAE OB7 0 AT (K AL
F, JEEN PRI 5y T BICPU.

B, WLt H A OB70:

o BPHLOB70H ATFAGH B IFAIE MRS Sl & T1/0T0AR Z 5.

o JHSFCB51RDSYSSTHIE RGMRAS. (SZLID=B#16#71) .

IR BL/OTL A HOB70% A gifE, CPUAENL.

WRTE T OB70I HHRGEALETU RN, WOB70EMANCPUH I AL I . HRGEIRFFLE
TR

PR R B FS B ol AR A 50B. SFB. SFCII VR4 (115

23.9.5 CPUTRL&%Eiz (OB72)

ki
WARMBLLL Rz —, H CPUIEEAE RS OB72:
o CPUNLKENR
o LLEAEE (WIRAM. PIQ)
o NV
o [P HTIR
o SYNCFHEHH
o il AR Ak
o OB72#i A kb T RUNBIR Bt ) Fi44 5 I STARTUPEL ) CPUSAA T

#EOB72/h 412
WA FISTEP 7760 PR FE b il — AN OB72. 7E2E itk th 2 5 th OB 724047 IR 5 )
e E R P RF 1 — 34 FEEICPU,
#itn, AR RLT H#EFHOB72:
o TETHOB72th R A BRI A F AR T CPUTLARINE .
o HISFCH1RDSYSSTHIE RGMIPIRA .  (SZLID=B#16#71) .
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o ZURRGNCPUMIITUA T RAE R I N
IE M ICPU T A4 %, JF HOB72¥ A 4FE, CPUANEH: JSTOPHIR,.
EMIN T B T, WTLIEH <0B. SFB. SFCHIH 4SS .

23.9.6 BfE$EIR (OB80)

L RA
A I TR R LI CPU R BV E R G0 FHOB8BO0. I IR A DR F LA, e
L bV N EZN ]
o R[] FiT B AR T T R IR b
o MEBARSCHINER R Z
E0B80H 4 #2

WAL FISTEP 74E i R s il A~ OB80. 7E/E b v S BEAEOBBOFh AT AL

TR EAE NP R T IR #5 F B EICPU.

it w2 LT H K48 H OB8O:

o ZHFAEOBBOH I B fF AIAE IEAS [ I B e e bt -

o JHLAEISFC29 CANTINT, Al LAMGH Ll (¥) i b i A fEAT e, R 58
HENCIEPSITIR TG RL IR e S E AR

RB AT (EOBBO G BeieL ) [ i BRI, U5 — MBI ) F I B e AT, iy dbes

WARBAT i FEOB8O, = CPUARLI B — AN [ B2 4 Jy STOP A

FEARR Y B BT LA AT 5COBL SFB. SFCIISERELN NI B«

23.9.7 HIEHFE (OB81)

L RA
WRAECPUM BRAEY R FC A LU R ks th I, CPUIKIERAE R 481 H1OB81
o 24VHIJE
o M
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24 [ B BRI OB 2 B (OBAEFAFBIRFN B IF IS B D

EOB81F 7%
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PATIIREP IR AR P REFP 10— 870 T 8 EICPU.

Bltm, wTLCA IR H #4 5 0B81:

o EFATOBST AN (F B LUK HIE HELWRA v s

o HEEHRAT A IEEBEIOHLA) S

o EPEERAEN LRI RN VA R T .

LR A OB B, IR BCAH 495 0B81,  CPUR I 21 v itk i iy A 23 %%y STOP
B HRRAME RS AP AN SIS ph DT HLAT iR AN KLEDITSE,  fEastiic.

LERI N SR FE B ool AR B OB SFB. SFCHIEEANHIfE & .

23.9.8 2HrH T (OB82)
15% AR
HF—ANEIEWRE S IR, W RAERE T e s iy, e BIa %, DUAAE R0
HFCPUEAE RS2 THHOB82,  (ZOBTE MBI L # 2 M AD .
7EOB82H 4 i2
WRAFFHSTEP 778 R AR A il— AN 0B82. 71 A it Herb 4 5 ZE7E OB82 Hh HUAT I 7%
7, e N R34 R BICPUT,
B, "R LLE H i OB82:
o  TIF{LOB82KI B EME K.
o BPUS 5 CHIBLIET A KT E M YINZ WS S .
2 —ANS TP W il & IS, A ) S PRI RRAR [ B b AR 2 e T OB R B RS I R X
NI FAHS W R S as bk, SR T AR I H B DL Rt AR ISR 1 )
B
EOB82H 4 'S A@ MR/, AT LLRE— 2D A AR 2 I i R/ 4, I 2
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WIREATHEOB82, iz b Wi fih & I CPU%E Jy STOP#R 2.,
AR B S B rp Al DAk A7 52OB. SFB. SFCHITH R M{E K.
23.9.9 i@ARIEBRAFET (OB83)
15t BR
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XA R AR T S A (E

R BRAERUNBLCUT A, CPUS R IIDHT AR (K 8 2 5 Js R SRR 5 DL lE . 2 2R DL
Bl XA T S8 F8n S BT STEP 70 M K12 Boft ik BB+ o

7EOB83H 4i2
WAAAEFISTEP 77E ] R FFrh e — AN OB83. 782 Bl [ B b 45 5 B /E OBB3 AT (1 B
¥ JFR e R R I R EREICPU
it WrLON LR H {8 OB83:
o ZEFAOBBIMH B K
o ARG Y)HESFCE5 459X Hif N IIBAIRAE 241 .
WERBA RS 0B83, YA/ T T BN, CPUMRUN®% 4 STOP,
TEARRL R B i AT AR 2147 5C0B SFB. SFCIY B4 {7 o

23.9.10 CPUmE4#kE (OB84)

15 Bf
2 CPURSIN 234 25 MPIS) 48 FrIH22 100 . 348 4 T VHUR 2 113 10 e o 32 4 23 A /O I K1)
B iR E B R 400 FOB84; Flln, 76 Rk LRI A — NAIERR(E 5 f . dsny 4%
At S I AZOBER (T Bk AN B IR % 0B) .

7EO0B84Hh 47ig

WAEFISTEP 7461 P R Fe AR il — N OB84. 7EE itk h 4 5 ZE OBBATh AT AL
HRE e P R I — 0 T AEICPU.

LA LR H A8 OB84:

o TEPFEOBBAKIEZNE K

o AL IHESFCE2 WRUSMSG K41 B R L W B AE X .

W OBSAK A G e, 4K B CPURE AR R I CPU%E ly STOPH L, .

FERI N BT B el AR BI45 5<0B . SFB. SFCHISE PELN {5 1 .
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23.9.11 “wiEnfFFigiz (OB85)

AR
CPUKIH#AE 2451 F OB85:
o M AWTOBI BIFE AR, EIZOBE T ¥AT R BICPUMI A REB AT
o YU AN RGN REL T SRR P A
o CYRIDH I FRMUR X I A CBEARASAAAE S D o
f£0B85H4RIE

WAEFISTEP 741 F R Fe rh A i —ANOB86 . 7E2L itk h 4 5 Z 7 OB8G Hh AT I AR
HREAE N PRI — 0 T 3EICPU.

filhn, mTLL LR H 4 OBB85:

o TEVFAOB8SI A A5 HAIH & WA B BIR s BAm AN (H e SR (K e df bl

o JHSFCA49 LGCGADRZE $kAH SRR T £F (K14 .

WREA 55 0B85, U Je g B A T 1] I CPU%% hy STOPAR A .

FERI S BT B o el AR BI45 5< 0B SFB. SFCHISE PELN M5 .

23.9.12 #ZE&FE (OB86)

AR
LRI E T B S, CPURERE RS OB86:
o PP REHIZLHEE CANEIST-3008AHIMEIMEBIER, 8l , Bl s st Wik |
MUAE F 10 43 A AL b 55
e PROFIBUS-DP Fifi. MulilffraiPROFINET M 45110 o: 880 R 4otk o
TR B B 25 PR A i OB B (A 2SR AN s T I R I F % OB
#£0B86H 412

WA FISTEP 7HEH PR T AL si— A~ 0B86. 75 A4 i e 4 5 B2 4 OB86 LA T 11 2
¥, IR AR R REF 53 T EICPU .

B, arh BT H E A OB86:

o ZLTNOBB6MHI A Bl 5 AN E WA MRS Bk A 2] o

o JHARLIIRESFC 52 WRUSNSGHHH BAE NS WTZEIIIX, IF Rk BEI M B L.
WRBATH S 0B86, eIl FUHLAL M CPUSL y8TOPHELA.

FEAHRE B By i ] BLEE 247 ROBL SFB. SFCIASEVEAN {5 B -
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23.9.13 @ifl$Eix (OB87)

15 AR
9 {ff FH T8 TH D HE B B A SR B TR AT B A B b e I A R, CPUMERAE R4 1R H
0OB87, .
o CYBRNCA R, A BAS A MRS R
o HT A REHREE B ATFAESRE S .
1EOB87 f4i%

WAUEFISTEP 746 PR F Al —A~0B87. 7R/ iderh 4 5 BE/EOBBT HhHhAT IR
TR BN P R — 2 R EICPU,

i, mTRLOG BT H KA HOBS7:

o ZFALOBST7IMH BN R

o WIRFRABI T4 R B i iR A (5 S B e, BE oz

WIROBS7 AL, sl B S 12 CPUSL y STOPHEA.

FEAR NIRRT B v il LA4R AT OB SFB. SFCIR B4l IIf5 .

23.9.14 “®miEE\/iIz (0OB121)

15% AR
Mg FE A R, CPURIERERZIRAOB121, #ildn:
o THEME I BEAAFLE
o AMAKIEETH.

fEOB121Hh 47

WAEFISTEP 7461 PR Fe th AR s —AN0B121 . 7E B S e th 45 5 AEOB1 21 Hh HUAT I FE
J, JEEAE IR R 4 FEEICPUT.

filtn, FTLLHLUN HifEHOB121:

o TPFfHOBI21MHENME A

o TEYETH A Hh A N R SR R

WERAGTFO0B121, ki 2 g AR AT 12 CPU, A STOPHIR

FERI N BT B o el AR BI45 5<0B . SFB. SFCHISE PELN M5 1 .
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23.9.15 1/OifE)iEix (OB122)

15 BF
MSTEP 735415 1) —AM S AR R N\ s H I, 1078 B3 () — YR BB RS 5 b 35 20 i i A
Wik, CPUMIERERZ4MHOB122, .
o EAEDTIIO AL CRARRIR B A F)D
o i) —/NCPUANRE TR HII/OHbuhiE
7£0B8122th 4772

WAL FISTEP 776 J AR AR i —AN0B8122, fEA BB h 4 5 2 {E OB 1 22 FH AT

Febe, IR ErE R R FEREBICPUT .,

AT AR HIAEAIOB122:

o ZEPFAHOB1221K 3% B

o ZLI RGN RESFCAA N it NSRS (1t — AN ERARAEL LI A AR 7 vl AR 78 30 < Bl
I FRAR A BB AR ST

WIRANG S5 0B122, 4Kl 21/0 75 ) 4 12 CPU%% 4 STOPHA .

FEAHR e Bl e ] LLER S 47 5C0BL SFB. SFCHIHEVEAN IS &
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24.1 FTEPIR B 30

H B 55 A2 IR e G 1 52 i, AT LURI 4R B T-STEP 770 AT BN REXS i A H 284
PRATED R, AEIH SRR TR .

T B R RTHTENEYER S
T LAMSIMATIC Manager AT ENGEE X AT 2, AR AT LT T AR SR IR S P 34T Bt

o

T PB4 AT R SIMATIC Manager ELHEFT B H ok

e AL SPAS QRS E e ()
G AR ZITIEIH H 30
MENHE

A&

SFTTFAISCIIR G, AN H (KR #1823 7T RAST R

Tt

DABRIE I i AR s RE IR R P b, R LU ETE 53R (R
AT R 44 R AN 2kt ik (1455

PN, AFE TG RE P& BB HE7 B2 4
LTl DI A A

A, AR R R P (AN S

SRS, Bl X WREER. FEPER . R TofF S ihlg
ESEEVEIES

A REHURAS IR S

A RAIRSCA O P SCARRISCARPE)
EBAFRASOR, Bl e g S
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A LU HTE AR AW DOCPRO, ARt SRR T ENFREAL 22 TMF o KA ) AL i rs
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FTENL IR

2411  FTEDBYEASE
FTENRL BRI
1. FIFHRMN S, TEbiSE b BT (S .
2. FENHE O B dr 4 File > Print 31T “3TEN” SHEHE. M8 10 5 L FE)7
FeHg RN —TnBEAZE “File” , 1 R ZALEL A%, W “ Symbol Table
(58 7,
3. EFTOURIEAESR, WiAT 2] DB ST BT CFTERL, FTERYEM, 3% , R
TS IEAE -
FUCKHHEHER “FTEN” 44, Blin “BEHER” XHERE, Al B ar 7 Eps iH e (4 py
7.
AT IR, rI7ESIMATIC Manager 1 f# S .44 File > Print EL#E4TEI.
24.1.2  $TEDINEE
FTENAT ST BAT M Sh e L 3%
FTEN X & KBHS Thak IhEE Thak
FIEN T TR e FTEN &
“CURIR RN “TLEATT
FRFPAREL, STLYSCAF File > * . . .
FEAR A5 18 — . .
4 R GD Table> * . . .
RIS Station > * . . .
PO NI SR File > * — . .
Z 4 Reference Data> * | o . .
e Symbol Table > * . . .
AR Table> * — . .
R 25> * . . .
* SJEHICAT, RoRSEAar A TP AISCThRE (i, FTED TR T B0 e )

RPN TEDXT S I8 51 S, ATLAAE “How to Print (WIHTED) ” 2 F 4k

£,

FTENFR 52

A “HTENTRNL” Thg, wT LA R o BT B SOR Y 0 =) o
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FTEN AR

iR

SCR A AT BV AR BT P AN B

RE TUE R LUK TS FA TR

24.1.3

24.2

YAEIEF

{3 ¥4 File > Page Setup, H] AT BEFT EIA T SRS & @ 45Kk K/ (BlinA4, Ab,
S DUATER T 1) (B A . Dh0a)) o AT LUK 24 [ B A SR 40 e & .

AR SRS I BT A Je) S SEAF 15 4T EARIRS 2o 7 SCRERE 88, A D0 TIA 4T BN 3 Jm 2 it b

U R P A UL R GO A CANAATT BTIAD  UFT BT H SRR SCRRAE 0 22 B L — A T
4, ATELEALANRET

i+t “Labeling Fields(Fr251X)” » T LI BEASFTED SCRS AT B 24 1§ Beise € 00 E A1 0.

KT HTED 3 SR 2 B 5 1 15t PR

FE “ATEDXN GG XAEHES, BR TR ZIG 2 4h, e nT LUE ik rh “IB IR e +1
B XTSI I

URAE “ATENER” kst “4xil” . WA DMTEM AN RIE R . ks “iese” . W]
CAST IV B o B LU I T I

=
RN

R PP PR BEE DS THT BV AT I, ANIE Y, THT BN R AN 7 3T ENA I A
AN R FP AT AR R B

151 B #0345

AT LLRE I H s U 48 BTG SR — DRSSO R b o S 4 A7 i ol 7w AAE R A gk
AT tA] ELAE— P S I Bl i BT (i, ATRRED

LESTEP 7+, A AR Th 8 rT LUK T R P -7 3R . HRS N AR P ARJFIPKZIP 4.01E 4
— ANy B S AESTEP 78 A N . £E.. \Step7\S7bin\i4% | Al LR B L 5 J
6

WA T FNIRFE R, MIRGERE FHIMARA (SdsmpRA) -

e PKZip Commandline V4.0 (4 & 7:STEP 7H1)

e WinZip MA6.0LL

e JAR  FA1.02VL L
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FTENL IR

VAR F

24.2.1

e ARJV24.1a (RESFTAMKEMIERY, WS ESTEP 741)
o ARJ32V3.x (HIiG&THMKE A
o LHArc RA2.13LILE (RiES Tl RE IR

STEP 7 V5.2 { % ##PKZip 4.0, JARFIWIinZip. 1B T4 M A e F e v) DS et Hopk &2 .

UWURAESE RLRASTEP 7 o, KA FHARI32 V3 XBIEEIERS S, R IR SR H g
A8 PR R o

FEHIPKZIP VA, OB AR i, 90268 B i i o8 10 6T 1) L A MK )y 28 7 o P I 1) 2242

& AR/

B15H (Save As)

UELE

24.2.2

24-4

M F3A7 he, nT AR IR H BA I DAL e SRR IR AT -
R LA st i«

o R EIA

o SRR H LMEE SO T IE H K.

AR A (R B R T 00, 16 “Save as” IUF HANFEH 2 HXGAE . TTH H 3 iy BEA
AR AAANAT TR A R, SRR I E R AR IRAT

B A L AT AL (K5 KA 35 A R A . A0 I H R A BIREAE, RN A
BOA Gl A o) o BT R B AR 0 H B, A “ VIR Thfg.

A FOFHE T 25 I DRAEASAE SRR IO 8], 200 AN RER SR AT DR A7 I 2% Sl tH — 2% A
o TR SR AT e AL A% BT it (R U Bl AN e 4

ALK I H s % LA 48 AT SR AR — DRSSO R o SRl e 4 i o A v AZERE A b gk
7, Wy e — B Bl Btk BT (iltn, FATRAD .

eI H e 2 R RERTIR SO e A — AT H IR, R P PR R P iy i
I EAT R R SR A SR SO A DI RE -

LA 28 16 AP N AN VARSI I H B GEREM IR 1B . 7 DR e A T g, A
LIRS B A s 4 RIS H B2

POVELEL:RE=RN

N TR AN EBEAT VRS, A L LA 2K
o WAHERG N LRI, AR T HSTEP 7S WAEL A Db ity “ AR



FTEN AR

KPR .

o A5 HERMBHETE—HI AN A BAENH B X2 WE I H FH R Z W . U EHCE
SIPRIREE, ARk A A E AL o AR SO PO X S

o STEP 7 V5.2 - 3 IARSFEFPkzip 4.0, JAR. (R 2780k & Nt 32 F ARJFILHArCHE % .

24.2.3 VAE/IREMTE

A LA H B ZEHEAT RS B, il T S By & M File > ArchiveEiFile > Retrieve.

iR
ANBERS H 48 BRSO (000 H P HEAT S W R SR AR AT ], L AR
BIPRS00 H 8%

MBATIRE RN, TH s8UE 2 A 3R BN H /S 2 .

WEBWRBEZR
n[ZESIMATIC ManagerH if H 5% #.1iy £ Options > Customize % € H 5 H 5.
TEAZATIGHER) “Archive” Hr, A DUEEEEY “ RS IR & B AR#ie” &0,
WERAEINTERK, IATER—AXGHER WA SRl “THAFEME” F “EAr i
REE” TTBCE AR HIRAE A M 1) H b A

B— NI EHE R E

AT LLRE NI 7P BEAT VAR, SRR RS SO R RIS B ot ml BLAE “ Archive CJEA%) 7
T AE P PR AR KB 1 H AR R A2
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25 {FRAM7A 4miziEHl R4

25.1 M7 RZ&1EF

HAWRAEPCHLLE IIM7-300/M7-400 H B L, ESIMATIC A& b, i 3
TETHEEAS RN Y o v LUE T R 2038 = 0 0 CHE = sl R AL B 1E = CFC GELRThAERD ok
i tHISIMATIC M7 R %

9 T HERFERE, BRSTEP 7246, RIETFEH TM7-300/400/ R4 B AF-M7-SYS RTFIH T
M7FERERIIT KR5S (Pro C/C++8CFC) .

YN
MAFEHISIMATIC M7GIEE—AN Azh#EHITT R, TEEm— RIVEARITS . TR T
TRZHOTH WEPAT TS5, IR I SCHREAP IR P RES T AT e T
W AT S 2 A B
v B i AR
et F Al sl % M7%Hi;
2% M7-SYS RT4mfEFt
JAZISTEP 7 [RS7
BT H gh44) [F]S7
BN A
JEVRTUECE SIS
AN TOE A RS [[1S7
E XA [FS7
AR CilE F B CFCH )% M7%H;
2% ProC/C++
BeEHRAE RS M7% H;
TEM7-300/M7-400H 245 4E R 50 %% M7-SYS RTH 7 Fit
M7 3AE AR 2L AR 7 Ry
S IR PR ProC/C++
BATIREFIMT 12K [FIS7, AHZEAH P A e L2k
FTEN S AR [[S7
EM7HRBHFLARE?

% FM7-300/M7-400, STEP 7RS4 T 4IThfk:
o  ZCPUIBH—#TACPUIM IR #A/E
o ELEE

25-1



M7 ] g R Pl R T

o AJRHIE IR
o JHTEEXZH

M7 RIZIEFI R A E R
STEP 7 0 FAM7 F] g 4% il SR e B A1 R oRe ) 19 S«
o {EM7-300/M7-400 2R 5 R 50
o I YR R G SCAHRAE RGHATICE
o [1|M7-300/M7-400%5 %% ] ) e
o AT
AT Vi M7 Al g B R G A RS, AR AM7 CPUSKFMBL TAES Wi H , 3k
TM7REP SO, R L A
PLC > Manage M7 System
TEM7-SYS RTH 7 T IHA7E 285 B i P 1R B0

25.2 HFTF M7 RiZaykIER 4

M7k 31
STEP 7434t T Fra B T A2 A T fig «
o TLHMA RS
o ONHREARREAT G E A SRR T
o L ML AER:
o TR
RigZEFSIMATIC S7TIEZSIMATIC M7, #ifsf X shfe. SIEEM7N R, B
TSTEP 724k, ETHEMTEBEHAE .

B " A
M7-SYS RT « M7 RMOS32#:1E R 4%
* M7-API R %)%
* XIMPII S HE
M TS7TRIM7[KCFC CFC GELLTIBERED LAt
EIES N A
M7-ProC/C++  JHF#STEP 7 523 Borland JT & R385 (134 322
R gmAE 5 A
« xdb386 = LT 5 AR L FL I 4 FE U
Borland C++ Borland C/C++JF &%

GEM7IERRAME, STEP 738 rI LLSCRE R AU N L
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M7 T] g Pl R 8

N

o MIZ LI (MPD M7 R nFEES B R LT R 5
o M XM7 ] e R G N(E B

o TEM7 ] gnFR PR GE EATRE BB E R M7 - T S A
T EZR T M7 M7 3635 50 (i .

C/C++ Programs

184

M7 ProC/C++

CFC Programs

0

CFC for S7 and M7

Borland C++

M7 SYSRT

FT e BIM7IE SR 1.

C/IC++Fif

* M7-SYS RT
* M7-ProC/C++
* Borland C++

CFCHF

* M7-SYS RT
- HFS7HIM7IICFC
* Borland C++
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M7 ] g R Pl R T

TR R RS

AM7R IR B T H, — R TSTEP 72, 55—y M7 ke eft: o
NIRRT SRR A D RE -

NG RIS
STEP 7 < CEMTEAERYE

- HHM7 A gafe st R 58

o FEL EBIFIBREM7 R

o BTN W H

« CPUE A

M7-SYS RT M7EAE RGEFIMT 2 G 1A% I35 B S0 BT Dhig
o FEFP AL BE (95 )

o PNAERTER YR I R

o WS FTSIMATICREA: £ 7 o)

o JhEE B

- 2

<A

- Wi

M7-ProC/C++ « AR K E B (K5 Borland i1 TT R FF BE4E A T-STEP 7 #1)
I H F55 S R AR

« AR T AE

Borland C++ o R CRIC++TEST

T S7THM7HICFC < B KRR CFCRE

« FB)IFIB1TCFCRE) T

25.3 M7-300/M7-400 1E&R %

25-4

T i 5 CRIC+H+E BN AR Y, Ak R IAE AR AR FZE o X FXLepv i,
Bl RGE A P HITS

o il

o EPEVEYH

o HSRGPILETNETIEIR

h T e AZERIES, SIMATIC M7 B8l SEHUEAM7 RMOS32 (SEI 2 4E 55

ERS) . M7 RMOS3245 ¥ e & 7 — MAAE D, M7 API ORI K
LB BSIMATICR S Z T

SN ERAE AR GEM7 RMOS3252 I 56 I AN 22 AT 552 S 1), A5 I 1] o)A T 3240 Ab 2.
XFFM7EES e AT LA IR SRR



A FIM7 7] g R Pl R 0

M7 RMOS32
M7 RMOS32iMS-DOS

M7 1] g e R G MR R GERC B IR T F I M7

RIERGFERE BB £ N 7F PROFIBUS-DPFITCP/IPE/E | REEGEFMEL
M7 RMOS32 FM 356-4 /4 MB FEfit- Rk =4MBEUE A

FM 356-4 /8 MB
CPU 388-4/8 MB
FM 456-4 /16 MB
CPU 488-3/ 16 MB
CPU 486-3/16 MB

Eiial o

M7 RMOS32ii
MS-DOS

FM 356-4 /8 MB
CPU 388-4/8 MB
FM 456-4 /16 MB
CPU 488-3/16 MB
CPU 486-3/ 16 MB

i b S e i e, i

Ttk =4AMBEA i
i

255



M7 ] g R Pl R T
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26

26.1

26.2

Er5HI5

B HRBZST SR P RIIRIR

WARAERHW Confighe IE—Muliff2AAS, JF B e —ASBihR, M a7

1. AR RE, KR M Hardware Catalog CREAEH %) T A 2 I HAAR .
2. TR HAR . NRRT RE R B AR AL ORI S 4

%71 LB IFREAR 4 A HTREAR I ) FLI B 2 B B R

Af LU S i 4 Options > Settings ( “Enable Module Swapping (i fERR A4 7 )
FEHW ConfigH ¢ a0 ET FFIZ D) RE -

BEXEMRZEAIINE

WIRBANHSFA Y, IF 1474 Options > Configure Networkifi [iiNetPro, LIf§
HAIER:, ok BalCE ARSI, oS A R F 4 S PE e HER R T

BT e K BRG BA, f FL7R Bl (I A, I 4 B ]
R, IF AT

1. 7ESIMATIC Manager P 6@ §i i H (g 4File > New)
2. JashNetPro (GEHifiz4Options > Configure Network) .
3. {ENetPror—Auh—A-ulkHh G g :
- Al fE, M Catalog i e il o
- MEE AL J38IHW Confige
- AR TIRE, fEHW ConfigH BUE HA BRI RESER (CPUL CP. FM. IFHX

B .
- R TR G ROX AR, TR AR IANAT, BRI TR, R g
B,

- PRAFAES, IRV EINetPro,
- fENetProt1, SERLBERIT M (REHT AR EIN 5, HARBAP T ED o

4. {ENetProrP 4IAIESE, ML BRLIE M 26IE R .
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ks ]

26.3 EFH

HAEAEISTEP 73 Rer, M B —SCTEid e (0 1)L, 38 5 ] G o 0] 0 Y sl ) s e i
(Tl VN (37

A AT 4 File > Rearrange nlMEAT HOBHIES . 1%L BERT I Bk Hh 12828 Py B4 3k e it
PR AT AN S, RIMEAT I H /5 e B A s B

ZIIRENS I H B PR A REAT UL, TSR ABL A £ A P B R P X A (9 SO A
AT AL .

FOBTHES AR B A I (e g T 2R sl B D, AR AT RE LU TR PRIIZ I BEAS
REE BT (B, KM —AIUH N ICIERATIZIIRE) » 1 N 7 AEAT SR HES 1133
H B I AT A o

AL H AR AT RO RSN, AR SE AR AN REAT IEAER L E T P iR I B, O IX
IS PR A7 UL S et Ao

26.4 WAEZIPWERRIEFTS

"] LAHILAD/STL/FBDREFy- g 4 4 2 M2 4 2 A W 25 PO T 5

1. kP A (B “Network 17)

2. JEAECTRUEE T[] I keI L e 1 45

3. AR i A REE T S

A LAAE I PREESE CTRL+ AL HE— DM REFP I KT 4%, SRS I 2% 4

26.56 HT=FRIITMIK

WERAME AR TR AR I, TV R DA R g iR T -

o AILIAE “FFS7 RUMINTESRIHLE, AT LI “Hbhik” R NTE S R L. RS
4 Hal A IEFREE R S5

o WELWIREMUE, N “Monitoring (AL 7 filk £ TE “Beginning of Scan Cycle
(FH#EATFE) 7, ¥ “Modifying (BH) 7 filk A i7E “End of Scan Cycle (1
HRH LD 7 .

26-2



PR

. ﬂﬂ%%iﬁhﬁﬁl%’“ﬁ@ﬁﬁﬁi, A LU s — /MR SR UL AR I R R . %P1, wT
IRAFIH R O i (1) 4

. /\ﬁﬁﬁﬁ)\ﬂﬁﬁ%i@*%)‘(‘kﬁ’]ﬁ% WA GE AR AT 5 R E SCRART S . B
B F NS 2 BHAS SHEE (Fli, “Motor.Off” ,  “Motor+Off” ,
“Motor-Off” )

o HLIZE “Online (FE£k) 7 #3325 ( “Customize (HES) 7 XFUEHE) rhoCp]# s

o DU LR O MOTIE R

o NP EN, WL SRR RS .

o JHIESAT, JFPAT “Force G 7 Thfg, WTLMEMUIMELE. A &= BRAL
A BB
fE “Monitoring (IR 7« “Modifying (f&2%) 7 . “Release PQ CEIIPQ) ” I,
WSHZ FESCHE, KA SHE R 77 ZIR -LTJL/K\EPJt“I\/Iomtormg(”*ﬁ) ” F1“Modifying
) 7

o KA —/ “Contiguous Address Range GEZ:HhHLIEED 7 -
i 3% ¥y 4 Insert > Range of Variable.

o I IRFH BRI :
A5 DR S i 2 AT DL R B oA A2

el =)

fF5: View > Symbol

57 % View > Symbol Comment
RAME MR View > Display Format
AFE IR AAE: View > Status Value

A BB View > Modify Value

o [AIMESE T LT I R
1 5 AR A AR TR L R ez, b b RS A B 2 X 4k
2 {34 View > Select Display Format, &g, R ML i
&’E*%Jﬁﬁﬂﬁﬁ‘ ARG LW
. R R A R -
- WSO AR B R AL F 1B, T AR IR KR
- W AR S BB IR F VR, nT ARG SR B SN R B

FEREFFOAEAR H, nT LR LB B — 2R AAE A #3000, T ] LU i s ofi b Rk
JiE A X S bk
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ks ]

o TERFSET, OKME A4 Special Object Properties > Control at Contacth) i £
B EE A T R

o C4HLAD/STL/FBDRE/F4iiE 251 “General” £k T “Control at Contact” T
(3 #4542 Options > Customize).

o CEIEF TR Hdr4-Debug > Monitor.

fi & & A52 “permanent/at the cycle start GRKA/EAMESD 7

WEFR S 3L, SnT DL— E ST N IR SERRAR & b m] DU 2 T3 B (CTRLAE) &

MEANHIN .

FE T HALK XA AT it 2 BN BB AS U A IR AR 1 o 20l I SO SR B B 7 AR 3R R i N W

MIESR, s STEP 7Rt &2 67, A ek H B 40,

wHFARfEN CE T B fEfks, & NaE BT “1” s sEFAEA CERHD

WA AT, MMESEHR “0”

EAWInCCR Ry E BN

L1 L8 B R S RS B IS R ZEWINCCH S SRR R i 8%, A WinCCI#8 3% 1
RV, T, SRR R A HAEWINCCHI “4edrA” , FAME SOk IR AT LS .
4’ “Controlat Contact” J&14.

26.7 ERITIETFMESS

26-4

SIEESTEP 7 il B I — AN SR PG W] i i 0L LARA- A 28 AN
HTATHSTEP 7, RAZIHHERUAF AN BE . RIS BRAT
1. FIF “wiilmb” , FH4r4Start > Settings > Control Paneldf X “System (%

25 7 Blbr. FTXP, BidSTART > Desktop > Properties > Advanced > System
Performance > Settings#] Jf.

2. fEWindows2000F, #EF “Advanced” Jfgiili “System Properties Options (&%t
PEREIETD ” $%4l. fEWindows XP/Server 2003 F, 7E “System Settings (RZ &
E) 7 FHEHEFERE “Advanced”
il “Change (B0 7 144,
18 “Ie/N AT DAOMB, 7E “BK” A% /D150MB.

WFAEMERE CBRAHC: ) L H Wi SR BRGSO T H R TMPETEMPHL

JEUG A 2 B (KZ120%430MB)

o  WIRSTIH 5 BRI E R XA, W AR KB 65T S730H KNI
AR,

o STHHAATHENX, HIERTLK.




A M

A1

A.1.1

BRI

HRIERR

BRAER ARG R

PAER AR T CPU EF/NMERE I TR) S PRES . AEn R B IR 2 A A S 2
T il CPU I ER & FH I .
S7-300 1 S7-400 A SRHL LA R 45/ E R X
e STOP ({%#1)
e STARTUP (J23))
e RUN (iz1T)
o HOLD (f#5)
1E STOP #i50, CPU #& 7 it A 41 AR 55 HH Sl 44 st ik 4 B AR AR 2 15 S BRA7(E, JF B 170
BEE e AR AS . £ STOP B~ H R AT
18 STARTUP 8T, BEX 5 a3 30255 “warm restart(B2JE3))” “cold restart(¥3 5 ) ” i
“hot restart(# a3 3h)”:
o YERERBNP, FRFPALBEMGKITGR, fHH RGP bR X BTG B (AL )
IE N E I VR X 7 S =R VAN
o A, EAFEMGE AL I HSTEP 7H R OB EE— 438 2 TT IR b 21
(&M TR 3h).
JI AT B SFCHE TAEAE il v Az BRI AR M s OR BT R g s HA ok B 2%
HAFEAR TR AR -
TG X R C I8 TS R AR R AL, B el 2 di2m.
o TEHJABIH, FET AW A SLEAT (E N A THEER R A EARRAL) . U B)
HAES7-400 CPU _E AT RERY .
£ RUN 50, CPU BATH PR, TR AR, Ab B WD fe A5 B RS
£ HOLD #ist, WP AT s, LU b A - F . A U H s
HEAT IR A AT REAL T HOLD £,
A X e A, CPU W LA 22 5582 N (MPO)EEAT I o

A-1



HEBREESX
W CPU AR I A HE S, B UL T RUT J LA
o off, HIHLJEICHT.
o M, BRI

R CPU AW, ¥ CPU U423 STOP, JeWrradd @, Wik CPU B3h, 4T
FFi2 Wr g vh X 45 ) EAT . Wk CPU A3, IR EH#B T .

BRIEEN ]
TEIFR, S7-300 Fl S7-400 CPU M #R/ERE X AR R 46

HOLD

A F 3
v ¥ 4. 1|r

STARTUP
STOP |e RUN
TR IR A E B U B 4
ik ok
1. FEREE YRS, CPUAL T STOPHAR,
2. CPU#%E JySTARTUPH 2 «

o BRI S i F 5 F CPU%E N RUNERRUN-PJ7

o i A Sl AR ) 2 5

o WIAHAT TRESUMEESTARTIE I fiE

FEVL_ LR RPRAMGBL R, PILTFRWI7ERUNIURUN-P

3. CPU#%[HISTOPRER, 4.

o (EJABIRLRE A B A iR

o HPIRETTOCEL e e 35 #5 CPUH; 2 STOP
o TEJABIOBHHAT T 1 HLAT 4

o AT T STOPIEINThAE

TEJA SR F Pl BT R, CPUR W HOLDE

5. TEJR R E T RO BT T 7EXIT HOLD " fir % (A Dife), CPU%%

JISTARTUPHE L,
6. CPUH% HSTOPHE, *4:

o JHPPRETT G HUE 1L g Fi dsF5 CPU%E Jy STOP
« 4T T STOPIl it dir 4

7. WHR R B, CPU% ARUN

A-2



bR

i R

8. CPU# [EISTOPRE R 24

o FERUNBET K 248558 FLAR N [ OB BB A 33,
o JHPIRTT Sk g fL g4 CPUR y STOP

o EH P FET R HAT T STOPAr 4

o AT T STOPH NI AE

9. R R B S, CPURE G HOLDAR R,
10. MY E T WA BT T VEXIT HOLD #5741, CPU#: ARUNHER
BRIEEA MR

A.1.2

g EN

UER AN AT 2R R, W e g s A E R g b filtn, BEsGESEIT R8N
RUN, iE7Egifeds L6 CPU B4 STOP, PRIMIX—#XBA i, Frid CPU %
STOP.

R X
P STOP
HOLD
STARTUP
AL RUN
STOP #5(

75 STOP N R AN AT o BT i HE A BE A 38 24 O DA PR UIESS I R Ak T 22 4R
Ao CPUfELU MR

o RAATRECER R W, B E)?

o JEMHEE AN TCPUBUE RS M E?

o GRFERA SRR S T AL ?

o RGRAEAA ) ?

£ STOP #E3UF, CPU 3 mJ A c 4 Jmy $e i I T BEAT 4 sl ) H 1A T AR, S DK L3 TR 22
X LA A HYIERAE AR SFB I HA A 21 A H)IER A IR SFC.

CPU f7fi#% nI {E STOP M RS A7 .l LUHATRL I SG(MRES) sl i g B 2% (191 G, 6 R
BH PRI T3 B

A CPU AE# 384 CPU [ 2)E (AR «

o TETAEAEf AR RIRAMBER ARt 35 P T (69 FH PR e LR A 1 M X B v o

o RGSHCPUMBR M SEA B A A BCE . TRALHTIR A MMPIZEUIRE .
o RN T A7 (Flash EPROM), CPUMEAFfiti (¥ FH P R 3 & 1 B TAEAFk X (ln

A3



B

RAFAE R ATE S A S EE T S B AR CPURMIBER 2 44) -
EWZAF . MPI S5, IR BL K CPU I&AT I Tl v E s B H AN S AL

A.1.3 STARTUP &3¢

75 CPU B R P A B2 W, e HATRESFEY . lid e s FE) v 4 5 k2 3) OB,
A LRI 4R e IR B

=Rl sl BEE s, AR, HAT S7-400 CPU f5 #ulesh . X % 4iH] STEP
7 HEAE CPU S HUH #EHE .

STARTUP AR RE W

o APLEZIOBHNFEF(OB100ME RS, OB101#iEs, OB1024 ).

o ANEEHATH A IK B OBBL FEIK S FR )T

o SEI AR

o IBATI RIS MRS B AT .

o BRSSO A i (T ek U ) )

Rziah
AR RGUEORAF A S0, MBS B2 S VFi. ELLREE )G, W2 mE—al e
U5
o TRt AL
o {ECPUNL T-STOPHIR FH M P FE¥
o IMEAR/BHEH H
o A RBGE SN (H T A B SCRR AE PTG B )
o EHGEE T WL TR AR I 1] BR A

FHEEs
LUF A LA iR 2 Bzt 8) -
o BLIERTIT
(CRST/WRST Hoe—— A
o GufERs FAHIN Ky 4 BB TR RE
(G RBE G PETT G ¥ RUN B¢ RUN-P)

W E N CRST)

EEulrF )
EEI Y =N N 5 )
o HIYEFIHIN CPUARTESTOPHE S,

A-4



bR

o BEZEREFF KW HRUNERUN-P.

o LHEEA AR,

o R AT CPURE Ha it vy v T (5 R ke s AL T K)o
CRSTAWRST 5t A 2 BEALZ 3 & 5 -
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B RIE BN A LB R 5 B — 2.

T BRI WA DR IR 2 34 H AL, B R 8% 4 2 R BN T S R B TR oK
S W A7 X R PELL T n] fig:

o WIRCPURNSTOPHE, WT LLIPAY 5 (15 [ f5 HLIK P i o A2 PR R i

o AES PRSI AR ) S A, 0 T RS IAT R

o LA RIOL AL Z AR R GEMA 1Y o

LHLNBHTHERX
Wb X s FHAE— IR ZEphas, Hig 2R AN DB AR S B 2 » XIS Y
IERN KNS, T — A2 W p S R — DU R . BT S AT ) J5 4% — A
B BHRH BN B S W X 8 —I0. 6T S7-300 CPU314, I HEMIHI A TEL

72 100:
IR W GATIX TN A& H AR S L 2 i A g . 748 CPU T AR E IS
AP K.
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BHETFAR

CWGAT RS RAE A5 AT BRSBTS

NG KPS (OB I A T2 )

WA R I TR S e G RO AT 5 RS P I U 8 75 A2 AR P N T AT e PR 722
A7 DR PRI o) B A 28 DA RS A IR Tl A0 1 30 0 o S0 R T L

X2 WA 1y R A

TES WA DRI SCANE S, BosrE EEE D3R ik sh R BT N5 2. X Le(5 R
(EELE

LS
SHIE TS

BT A3 1B

3112 % FHEAEAF IS B B B AL R3] (UL Jes T, A
SR B IRk A

SR

1 “Help on Event(ZEFEBY)” 24100 LA 7R 7E L 38 %) 2 HE /R 2k A SE2F 1 B n s & o
TE RGN ARG Th e 022 31 B o] LIS B4 1D 145 B

FREATE— XA

1E “Module Information(f4545 5)” SHEHER) “Diagnostic Buffer(iZWigi4£1X)” k%
fEH “Save As(BA7R)” $54l, W LKIZWIZEA- X iR N 28479 ASCI SCA

BRISHIEEX

Wil “Module Information” XFiEHEH 1) “Diagnostic Buffer” #x%&, SrEFE) @ H &R
ZiYifie SFCoI RDSYSST, wJ LAfESi s b B R iZ Wrge 7 X I A

FHLETRI R EHRAL

FTLARER RUN #24 STOP Hir/a — M2 Wigefr 5 HIE R — g sad i it v L (n
PG. OP. TD), LMEPRMEBEFL IES | STOP B H 1.

A.2.3.8
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S7-300 CPU L HRIFTEIEX

TR B YRR FR B, CPU f7 i 28 B AT (MRES), S7-300 (K174 2 (Bh AL A7 i 2 (RAM).
AR A7 fits % R R G A7 it 4% )Wl 2 07 9 L DA B A7 76 1 28 DI 9 BT s i E k. xd
S7-300 CPU, WTLLH BAF AR FE T S A4 «

SRR o PO ORGP AERE AT it s . TARAF filias LA 20 R GUAT Al 4 110 A s Al
" LUK R P AFAEEPROM(BE T LU A7 it R R T LU SR IAECPU LR, 2% “S7-30071]
GifEyshlas, MEERZEE” T

WIGCPURIANF],  m A A — 5 O A Bl 72 3E 2 R IXEINVRAM .
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f£FH NVRAM

$7-300 CPU 7 NVRAM(FE S 2% RAM) FR 3 (it —AN DX 3 (LT ) o IR CUKEFR P A7 2125 3%
%) EPROM h, v LRI 207 CPU 47— & M B (SR B Fi B 24 CPU M STOP

557 RUN).
S7-300 CPU _L1¥HE 5 R AF- g IX.
L T
ABAERE || THEESE | (NVRAMD RYAs
#(RAM) X
i SMFFEPROM £
#(FEPROM) i) CPU

TSI —DhfE, BEE CPU LU N Hii frAr /£ 2 2k RAM

o DB AE (IR R R IRAFAE R B it ds IEPROMM , X FEHCA A )

o GEMNESATH SR

o (IAFRERIEE

FEREA CPU b, WUl — EBOR I E I &5 . THEGERNIERRAL, I8 mT DL E — i B
T LA A% DB e it Bl .

CPU [¥) MPI s hEA# it/ NVRAM o I gitifi P 1 CPU 7 fst HLBA 7t 4 S A7 5 T LAEA T I IR

& A5 & Bt RIP AR
AR i 6 L, BB i S R A A e AE I (2 v LLOREF . R 413 CPU, A
SE I s THECE AL AF A S DR AAAE NVRAM 1, AR A8 H] T 5 4 i, XS BT
T RADREE .

2075 NVRAM RYEiE

i H] STEP 7 413 CPU I, A LAYk g WRANAEAf X 0 T RHF 1K o 1T AR AL 255 NVRAM
(At o O BOR ARG DT A T K CPU TIE . I Bom ANBELL CPU JrdR e % H £

A.2.3.9 S7-400 CPU PR #FTFIEX 1

T la & it RIRAE

WERAERH Ja &t s 00 N EE R EE, S dida i I B8 A CPU {71 %% (MRES)
I, S7-400 CPU HUAEA s (B A H AR 2 (RAM) . TAEAEAE S8 RSB i A7, X
e X g Hh BT B R R AR .
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BeA Ja i, RREIERES)IF H e ml iR Fr Dk, is)s, R4 MPIZ%(tn CPU

(K] MPI k)3 DR B RO o S RRAS 7 LYt F S0 fid 4 SRV AT PR AT TR TR
BlRERIMAIRIE

D SRASE Y P Tt 26 0 Ak 245+

o FJIEHLE, MCPURHEZNIN, PFraRAMDIR 4 N A R B o

o (EBGEDNERET, ALAPREAS . A2 AT AAS B bk X P B . B R A AR OR

o BR T BN AR S B SN EES 2Ah, RAMITARA7 A s 1K) A A

731

PATSRFFEIRE X
A LU — € B AL 8 I S AT Bds B RS D RECBCR AR P A K CPU 1
SE)e FEBGRENIERES, MAA]JE & A, X T R
M H] STEP 7 ST, v LUE CURESA A7 ds . 2 I e AT S asAE RS Bl N 2R B
B CPU Jir S B i -
2 (0T SCAT IR FEAF A X IR B, AT2% “S7-400, M7-400 W] gwfed=iilds, 452
WA 2% TN

A.2.3.10 FAEIEFFESRPRYATASHFEINR

F48 CPU ] LLE HWConfig(RE 240 2&) v 1 B 1 G SR s sk 2 W 22 17 X B2 i kN 5l
BB, LTS AR sk vl LR — AR IEE 4y . X4 CPU (S v LLZE
CPU B EME “Memory(f7-fitids)” b oR( “Details(FEGN £idw)” 2401

TR A i as A TF T B A sl as LUR, MBS, LAthdT— N Aiks).

A3  HIREBMSHAEE

A3l ASIERRAMSERR

FH PR o (0 A Bl 2 b AT — AN A . nT B SR A LU LR
o STEP 742 HE M EEAH IR A

o JERE A A FEAKCE AR A B ) 5 A A 2

o JHkiE AL FBEFCS 2 Bk
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—RRiEE

TEA)ZR . MBI B8 A F R 2 KN BE T % . B RSe A A lln,
LA AELIEFR A (STL) LK move(#8))354(LAD Fil FBDMEH Z 1. FRIXF .
—AE A RERICT 0”7 B 417, AN )AL, AN TS, AR
F =t A

BeAe A WA 75 . TR T . XA F XU Rk o] DUH & Rk g,
ARSI EIMEEE

MAE RS FHER, 8 RS I B IR S i — AN IR R (LR R) . AR B
I AT AN [ e I TR B 7 s i

AT R T B RE B T 5%, FRINH — 2B Rw B ks 2 OR BAE e 1t
.

L5 Fr 5 firag % b KlEFRRE

Hexadecimal 8,16 F1 32 B#16#,W#16#,and DW#16#
Binary 8,16 A1 32 2#

|IEC date 16 D#

|IEC time 32 T#

Time of day 32 TOD#

Character 8 A
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A3.2 EAREEHER
AR BAEMEN KT, FRI T AR AL
EEFHIAR | BT & | 1ERNIEIR SEEIREERTE (RIRE | =~
Hr#g EZxaE)
BOOL(f%) 1 A IR S A TRUE/FALSE TRUE
BYTE 8 ot B 16#0 to B 16#FF L B#16#10
(%) L byte#16#10
WORD 16 — R 2#0 to L 2#0001_0000_0000_0000
() 2#1111_1111_1111_111
o WH#16#0 to WH#16#FFFF L W#16#1000
L word16#1000
BCD L C#998
TR % C#0 to C#999 L B#(10,20)
B#(0,0)to B#(255,255) L byte(10,20)
DWORD 32 R 2#0 to 2#1000_0001_0001_1000_
(AT 2#1111_1111_1111_111 1011_1011_0111_1111
M_1M_11_11
o HE DW#16#0000_0000 to L DW#16#00A2_1234
DW#16#FFFF_FFFF L dword#16#00A2_1234
BCD B#(0,0,0,0)to L B#(1,14,100,120)
T2 1T B#(255,255,255,255) L byte#(1,14,100,120)
INT 16 B AN R a e -32768 to 32767 L1
(B %)
DINT 32 A 3t L#-2147483648 to L L#1
(K, 324%) L#2147483647
REAL 32 IEEE FFR:4+3.402823e+38 L 1.234567e+13
(77 150 77 R FBR:+1.175495¢-38
S5TIME 16 S7 W, 45:10ms | S5T#OH_OM_0S_10MS to | L S5T#0H_1M_0S_OMS
(SIMATIC (B A5 1) S5T#2H_46M_30S_0MS | L
i ) and S5TIME#0H_1H_1M_0S_0MS
S5T#0H_OM_0S_OMS
TIME 32 IECIHA], 451ms, | -T#24D_20H_31M_23S_6 | LT#0D_1H_1M_0S_OMS
(IECH fi]) 5 4 48MS to LTIME#0D_1H_1M_0S_OMS
T#24D_20H_31M_23S_6
47MS
DATE 16 IEC H, 43 1K | D#1990-1-1 to L D#1996-3-15
(IECH 7)) D#2168-12-31 L DATE#1996-3-15
TIME_OF_ | 32 I TEEE 1 ms TOD#0:0:0.0 to LTOD#1:10:3.3
DAY (I i) TOD#23:59:59.999 LTIME_OF_DAY#1:10:3.3
CHAR 8 ASCIl #5F A'B'etc. L'E’
(F-4%)
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AR INT p94830(16 I EE L)

NERAT TSR E R N IEEEOE R AU (16 (L) FE AR S T

R AN TRRPTR AN R TE (16 ) o

FEH(1617) -32768% +32767
TR A4 1) TS KRR .
i 15 12 11 8 7 4 3 0
|o|ooo ‘0000 ‘0010 ‘1100 |
s THEEIE . 32 + 8+4=44

4R E DINT a94830(32 L8 4)

R AT SRR E R IEEEOR R A U XU R A TR

PIAST, RPN A AR T

HA(S217) -2.147483,648% +2,147483,647

B s o #4-600,000 ) RERIRS R R . £E BERIR ST, B TETE SRR A X
ANEEE LA o T DL R AR A HUSOR A I 1 A3 B M

31 287 24p3 20h9 1615 12 i1 8 [7 43 0
ibihihfiibiaifrii[1iojofofoltiof1]1i1frfol1[1{1]o]ofo]0]0]
g

B LA REAL RIS (Z5E)

o U RIEIE Ay “HH=m¥E 19 b KA. FEH “b” MHREL “E” REBHG R
({m” %ﬁ}ii&c

X EAE 2157 AL s AR A R AR 22 18] A B AT LR 7R — AN AR R B et v) AR s — A
AEHNIE A R B AR £, nT DUBL o — N0 L Y T

e WAE TRV SRR B B R B, SRS BRI, A 2008 1 Bl R B (I
TS N EURMESREOR BT, DD AT FAT A (R4 A B fe T AR o
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STEP 7 HHy;Z S8EX

STEP 7 "h % SUB-& — 3EHIF A2 8 IEEE ArviErh ANSI/IEEE #rifk 754-1985 5 e H A
L AL . BTSN )

o=}

558
fiflie=E+bias(fits), ML (iEE=+127) 870
RNy o AR AR B AE i, PUNER B EE N e R

EERE

TE AR — 3L Ay F— A R7(32 A7) :
for
31 28 27 24 23 20 19 1615 12 [11 87 43 0
s | e | f |
| - ~ J S— _—
GRst 54l e Fefm
(147) (847) (2317)
BT g — AN s A B
FR AR TR s &
5SS 31
fe4le 30 207 K
fe4le 24 201 I
¥a%ie 23 200K
J2Hm 22 211K %
Jetm 1 21)-22 %
JEHim 0 20-23

A =AHETL S s, e flm, KRR PEE AT CLE PR AU X
Bl=1.m*2 [f)(e bias) ik, XK.

e: 1<e<2b4
Bias: bias=127. XEMAETREAT AIMNGE N5,
S: IE%S=0, #%(S=1.

FREHETEE
LA E PR o X, A LUR SR

A-26

/NMOTE R E=1.0*21(1-127) IR %=1.0*2[1)(-126) X =1.175495E-38

B K R B =2-2 10 (-23) Y * 2 14 (264-127) IR =2-2 19 (-23) CRE * 210 (+127) IR
=3.402823E+38
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FEHEE R AN e=m=0; e=2565 il m=0 £/~ “infinite(I55F K) 7.

&K EE"
54 ANSI/IEEEARVEE [R5 f 8 -3.402 823E+38%-1.175 495E-38F10LA J%
+1.175 495E-38%3.402 823E+38
T B AE T AR % B P R m B R 2 4 R RS T B AL IS IRES
T HE REE cC1 cco ov 0S

-1.175494E-38< 45 B <-1.401298E-45 (41 %) F %

+1.40298E-45< 4t < +1.175494E-38(1E 1) F i

£E 0 3. 402823E+38(#1H) i

45 >3.402823E+38(1F 1) - %

ANAT BT S B AR S Gl MEAEAT RO 241

= —=]10O|O| O
= O|—=|10O| O

1
1
1
1
1

RN RIENS NN NN NN

AR AR A N

B, K ER-2 SRR, SRR AR R A AR L, AT AR T
ANGE R I FERE B AR ST, B B SRS

18 5 B I AR R

B, A —F B AR DRI, 7T LA T N I S B T, 7T
FFARITAT LA AR R — AT T

FRBITE R E

/N

iE
WA AR RKAARE /N — KB BUE TSR, TR AR 45 R

£ STEP 7 i i BT LIRS 21 6 A HRE AL, PRIk, UIRmATE B Bony, &2 L me

g 6 AL,

'R

TR AR 6 LR, B, WREUE 1 KT RUE 2210 1y y TR, XL y>6 %K
{1+ 2=44 (i 1

100 000 000+1=100 000 000

PEFER S LB Uk S E ]

TR CL 2 R R R 3 K 5

e 100

o P(3.141593)

o 2[FJi(P2=1.414214)

S AR B HE 10.0 BOTE RCEORS(H NI 7R 4120 0000) 407 F

A-27



B

e=2 111 RF+2 1) 7 I #=2+128=130
m=2 [f)(-2)X%%=0.25

KRR TR
(14m)*2 1 (e-bias) K 7¥=1.25*2 [¥)(130-127) X 7¥=1.25 X 2 ] 3 X F¥=10.0
Decimal value 10.0
Hexadecimal
value 4 1 2 0 0 0 0 0
Bits 31 2827 24|23 2019 1615 12|11 8|7 4|3 0
0i1iofo[oioio{1]0j0{1}0[0f0 {0 j0j0j0f0}0[0{0f0{0]0jO}0[0O[0j0{0 {0
Sign of Exponent: e Mantissa: m
Mantissa: s (8 bits) (23 bits)
(1 bit)
e=27+21=130 f=22=025
1.f _ 2e-bias = 1.25 23 =10.0
[1.25 _2(130-127) = 1.25 _23=10.0]
Decimal value 3.141593
Hexadecimal
value 4 0 4 9 0 F D c
Bits 31 28/27 2423  20[19 16 (15 12|11 8|7 4|3 0
‘0i1i{0iojoiojoiofoi1i0io[1i0ioi1][oioiotof[1i1i11]1i1i01][1i1i010]
Sign of Exponent: e Mantissa: m
Mantissa: s (1 (8 bits) (23 bits)
bit)
Decimal value 1.414214
Hexadecimal
value 3 F B 5 0 4 F 7
Bits 31 2827  24/23  20(19 16 15 1211 8|7 4|3 0
ojo{1i1/1j11i1]1jof11joj1 o1 ]ojojoiojof1jojo [t i1 Mot it ¢
‘ e
Sign of Exponent: e Mantissa: m
Mantissa: s (8 bits) (23 bits)
(1 bit)
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A3.24 HIERB AFIWFH_

g -2 R £ (BCDR 2

pei o E T Iy il Ak - B

A AR RS A 4 MY

AR ARSI TSR BRI S . LA 4 A 4UB 716 ) B0 (32
Br)o doe i RN A RLFR R BUEANFT 5 (1117 48750k, 0000 F&7< 15 )f ] BCD Zifth kil

i & HVPAl SR A7 (70 16 40, XU 31 4%)

TRRPR N IZ PR BCD 4% X AEE

3

F(Word)
(1647, 3{7BCDHS K& 1F45)

-999% +999

X F-(Double word)
(3247, 7{iBCDIY K FF

-9999 9994 +9 999 999

B g B - E R s 1«
o TFHEK

fi 15 12 11

I
-‘_‘_‘_—_‘-—""'—-—-—.__

8 7 4 3 0

CiiRcE

[0 0 0 0J]O O
[

(102)

10 0 0 1]0 0 0 0]
+

|

(101) (100)

o BT

i ///

-9 999 999 H‘J?ET W)

28 27 24 23 20 19 16 15 0
|11111001|100110011001 |10 ] s i)
55 EPJ] 7] il + ] H i~

(106) (105) (104) (103) (02) (101 (100)
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A.3.2.5  #IEEE SETIME(RT a4 E)HI1E =

8 SETIME $id 25 A TS BE R, B\ DL B2 0 1 -T2k X7 . T BT
TNHIETAE A 127, B3 1s R a) kb e i e 25

15... .8 7. .0
|x|x|1|0‘0|0|0|10|0|1|0 ol1 1111
H__Y_/\_ —— P —— e ~— vy

l 1 2 7

iNErs BCD #i5 ¥ if [H)E (0 to 999)

1#

JoK: A BN XL B AT

M SETIME I, 2 A —A> 0-999 ¥ [l 3 (I TRME TR W 2R (L 36) o I HER 78
IS gt LU 2R R ) B — A B — A B b el (), ELRIK ) 0,
S5TIME AR E

A& = e o
10 ms 00
100 ms 01
1s 10
10s 1

A LA R B A% Pk — AN I T«
. L”W#16#wxyz
- X HL ww= G (B s ) 16 R B 23 2R
- X xyz= TR AL 1 2 A 2K e A
o L"S5T#aH_bbM_ccS_dddMS
- XH a=/pI, bb=23gl, cc=Fp, dd=Z=#
- WL E IR, IR R TN SRR N — NN AL
AT LU N BB KT TR 2 9. 990 #, =k 2H_46M_30S.

V=L KA STLS S .
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A33 E&EIEER

S EBHRFRT LoE UK T 32 A7 (8 10 % sl 5 L e Bl 2R i i id % . STEP 7 A2

RSN NCREy CEERLY

o DATE_AND TIME (H SAFNHa])

e STRING (F4# )
o ARRAY (%t41)

e STRUCT (&5ta14k)
o UDT ()75 SCHIS 25 7)

e FBFHISFB

FERIIA T E G, T AR A B AR 5 7 R A el e e USSR RITE AL

HEEE ik

DATE_AND_TIME | 5 X —AGARE (84 F5) 1 DX 5k o IX Tl i 21870 DL — 338 41 4 A 1) -3 4%

DT A7«

STRING B e LA W 25405 CBIEZRTICHAR) HIE . 7l 245
PRI AT HE X 48K 256 7715 o X S AE A 254N F45 e 25 B 8 B A B 1 2% T,
AT DA ST B AR T4 B P I R R Rk > — AN 74 B BT
KEAAERE . (4. string[9]'Siemens”)

ARRAY SE XA —BE M GEARERE AN M2 4ed. 6l
ar: "ARRAY[1..2,1.3]OF INT" & L T —A~2 X & A 138 55084l . my LA
FHRAR (712,217 V5 MAEREAE — B4l 8 . mT DUE— AN B0 ds
Z B N6YE. N LR TS (-32768%]+32767)

STRUCT TE X AT B BRI A A . wian, AT LU S i S5 AR
FON B — A HH 45 R PR TN E 2 201 1 1 485 ) A

ubT 2 A R B B e AR e I PR AR R, R AR A R R i (A A i D
BTN - AESTEP 70, W LA B A R A B E 2 LA i H
FrE X B2, UDTH eM1E a4 7l LU R

FB,SFB BT SEURHR M S5 I VAR AN S DB L% JLANF B 175 53¢

SR ARKEE R AT A N 5 7 k) BRI — BU(WORD #:51)

A.3.3.1 #iEZZE! DATE_AND_TIME 89#&3%

2] DATE_AND_TIME K S (DT )4 A FHGIRTI (I I, iy A DA 335 2 A £ - 2271
K XAEAE 8 AT 1. DATE_AND_TIME HiHfi 8 A4 il i B

DT#1990-1-1-0:0:0.0 % DT#2089-12-31-23:59:59.999
NAUBTR S 1993 4F 12 [ 25 HAEMIY LA 8 1101 43 1.23 B2 HIWAIH [RITETL,  n47 LA

IR
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A-32

o DATE_AND_TIME#1993-12-25-8:01:1.23

o DT#1993-12-25-8:01:1.23

LA RABR I IEC(IH B L THARZR Gy 22) bR e BE W] LAX) DATE_AND_TIME %t 0 £ ik

AT H:

o CEHIE—TIY H BAFNE A4 DATE_AND_TIME##E#:: FC3: D _TOD_DT

o JDATE_AND_TIMEA% 28 H #i:
o JDATE_AND_TIMEA% = 2 IR B
o JADATE_AND_TIMEMS R Fp 42 H 4

FC6: DT_DATE
FC7: DT_DAY
FC8: DT_TOD

RTINS H IR AR R A A, H IR RS LU ER s A, 12
H 25 H, 1993, H/& 8:01 X 1.23 >,

FA BN 2451
0 4 B#16#93
1 H B#16#12
2 H B#16#25
3 NI B#16#08
4 45 B#16#01
5 B B#164#01
6 L P B#16#23
7 AN R VA B#16#0
(4MSB)
7 S B#16#5
(4LSB) 1= H
2=JH—
7=~
FEm DATE_AND_TIME o4 ()76 [ 2«
o f/h: DT#1990-1-1-0:0:0.0
o k. DT#2089-12-31-23:59:59.999
Al RERYEHESE Bl BCD#5
4 1990-1999 90h-99h
2000-2089 00h-89h
A 1-12 01h-12h
H 131 01h-31h
NI 00-23 00h-23h
i 00-59 00h-59h
B 00-59 00h-59h
) 00-999 000h-999h
2 Sunday-Saturday 1h-7h
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A332 (FRESIIEXRE

A DU 2 A5 S AR A 2 B R A i DA A B SR, T A i (1 0 2 7

o HALHIRFMARRAY): — AR E— A — R B s — A s

o SEMREHRZEMSTRUCT): —ANGHIARLLA AN R ISR R — ANt

o ERFHR(HUERAISTRING): — /NPT E T — MR 2547 R (i KB CHAR) )
YR TR R I S BRI S R S S A UL

o [IIAFNIN o) (3 2 HIDATE_AND_TIME):  HIAFIIN B R MAr 4= A H . /NI
9 By =RRUE.

T P 1 R R 8 ) A e AT A — A DX P R T B B IR AR (S B . T LA — A

DB &(—A> FB. OB B FC I & 7 v g X — ANl s — AN ik id

Structures
STRUCT

INT t > Integer

BYTE ——* Byte

CHAR | > Character

REAL " Real number

BOOL | .

\\
S~ » | | Boolean value

Arrays 1,1 Integer

21,2 I Integer
1 1,3 + Integer
ARRAY [1..2,1..3] i
INTEGER (2 1 I Integer

> < 272 | Integer

I

2,3 I Integer

A3.3.3 (FREAHEEE

#4H

— AN AL B RS AR A B A A A B — A 6. AT RUVE R — AN

IR, e AR, D IE LR T

o GHHIRE LT

o JHREETARRAY B —AN 4.

o JUTHRTEEEALN KN, (ERA P fa e R — 4k (I 2 648 M 38— DM Rl J — M. 7
—ANHFES TN TR, G2 NAESRIT, 40— MR —AEiz n
WA S B, FA bR T A S YA
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= 1

w5l 2

e % ¢

A-34

(1.5, -2..3, 30..32]
o FREHA P RO A B A

FEPTRE AN AR B . bS] DO AR B . N ARty
FESHRMEE. Bl 5 AEI TR Op_templ2].

TR AT LA AL HE 5B TE N BT B 450 (-32768 F+32767). T B B4l AT L X
ARRAY[-1.1]. SB—ANIE I FARNS Op_templ-1], =4 Op_temp[0]& =A%)
& Op_templ[1].

0.0 STRUCT
+0.0 Op Temp ARRAY[1..3]
*2.0 INT
=3.0 END STRUCT
1 Op_Temp[1]
Op_Temp = ARRAY [1..3] Op Temp[2
INTEGER 2 P _Temp[2]
3 Op _Temp[3]

AN T DLHA 2 R RO DAY . R B T A integer) ) 4E 4L .

11 Integer
1,2 Integer
1,3 Integer

Op_Temp = ARRAY [1..2,1..3]
INTEGER (21 Integer

\—P 22 Integer

1&3 Integer

AT DA R bR i) 2 dER Bt . ARG, B EBUE Op_Templ1, 11, =4
J& Op_Templ1, 3], #PUANE Op_Templ2, 1], #H//N&E Op_Templ2, 3.

— AN R 2 T BLE SCRINAE B, AT LR AR Bk A2 B Op_Temp & SO /N AERAL :
ARRAY[1.3, 1.2, 1.3, 1.4, 1.3, 1.4]

XA E AN TEMN Firie Op_Templ1, 1, 1, 1, 1, 1. e —PmEN Firh
Op_Templ[3, 2, 3, 4, 3, 4].

£ DB Herh oAz i i W2 i r] DU SCERAH . /e 6 7 B2 N 20 e DG B 7 (ARRAY) & L5 75
FESHRRA, W PR:



Bk

(IR PR AR R A

7522 HE R P EHR R JLE IR AR B S IR T 5 2. IR A4~ 2 X
3HAL A

0.0 STRUCT
+0.0 Heat 2x3 ARRAY[1..2,1..3]
*2.0 | INT
B 0 e srocr
AEEMANVIIAE

2RI AT LU RN CR IR T MR . STEP 7 SR 4R NI AR {10 5 i
o RAMEMEA: TR RN EAUCER TR E AT R R B 2%
TERMIMUFHREHAL: (1, 1] IEREAN TR L AHIZ SRR IT .

o TREEERE: MMUFRICR BAMEIE, USRI E TR M (ER R
HORMYIaME . WA R RIS AONXy), KEXEEE R, yEEER .
WERAE ] B R AL 1, T L2 R s A B RN AN JC R B EYIaE: 17, 23, 46,
566, 3342, 0. thn] LLEHTE 6(100K I /N CR ATAAE BN 100 & T BLO | A

JUEARE R E IR AR A e ARE N 0, Wi 17, 23, 4(0).

e #4A B EL IR

A DU I H A PR E TR ) bR R B B . AR S A e .

Bt b A RS N DB20(moton) S —ANZ TFEG, AT DU R kb i) B i
FATOE:
Motor.Heat_2 X 3[1, 2],

ERHAEDSE

A.3.3.4

Ltk

AT LR B N SR AT AR o SR AN SR AR R W R D B, WA 2 A
MR BATCR) . MEAHF A ICFE A DAL 28, R 2
TLR LS SHN BRI .

WERAE B 0 28, ML S HAA(ENREATEL ). N EEES M
KGR i, — O 2 X3 B, R MBS 2 X3
(KRR, AN SE S0 2 X3 (MR A A

R &5 ¥y 1B 2 4iE

SRR A B B BRI CEA R R S Hi Y, WIS M A AR ot. T
A LOE it Refiile P, mRR S5 — MR OCRAR A Z A e . R
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PRy A gk, s N, AT AR AN RO R R

STRUCT (
INT f » | Integer
BYTE | Byte
CHAR | » Character
| REAL | Real number
BOOL —_
\\
h » | | Boolean value

AN Z WA UZRE I, A e aE e S A S 1) .

SR RIS
27E DB Hh i MZ AR B A A ] E LR A

FEE A HK(Stack V], Za MRl FIeE, T T4 ),
AT (T AR, — AN ERFH TR REmiD), —ANF U T A7l ) DA
B AR Bl (T 4R A 5) -

Address Name Type Init,Value Comment
0.0 Stack_1 STRUCT

+0.0 Amount INT 100

+2.0 Original_data BYTE

+4.0 Control_code CHAR

+6.0 Temperature REAL 120

+8.1 End BOOL FALSE

=10.0 END_STRUCT

A= EAEE
WER B — DGR R TT R DM ECAIAG M, 75 ZHRE — M2 R A U A TR
4. B, BCCL T Iaa e (s LI b A W 2R 1K) -

Amount = 100
Original_data = B#(0)
Control_Code = C
Temperature = 120
End = False

BRI T RO 15 53R

AT LT ) SRR R AN G ER . AT DM A5 btk (U, Stack_1.Temperature). AT LL$R
SE TG FTAEIZat kit (1914, ik Stack_1 f2F DB20 fRF24A % 0, amount {445t
k& DB20.DBWO, temperature [ 4ax ik & DB20.DBD6).

REMEIEASHE
A DMERAE A SR ik . W RAERR B W] — N2 HGE W STRUCT(S5#494%), i
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WA EAIE— N BAMIEICR KGR K o TG RR T B T0 3R th ] AR 25 I R )
24, HEE MR o 5 2R EER A .

WA GRS H, I EAOBES M2 R A IR TR, a2 BOmE
(K0 B A 2 AR ) PR MU HE 51 o

A3.35 (AP EXHETELEE S LR

R R EX B EZEE
FP 5 SRR R AL (UDT) i LSS EEA AR & B0 288 nT LUy UDT 485 — 447
H HAT DA A YA AT EAT. BB 8 U R AR K 4, B ds A
B AT AT RN R

uDT20
INT > Integer
BYTE ———*» Byte
CHAR ————» Character
REAL Real number
BOOL S
N
h > Boolean value

AN BN OB A S — AN SRS AT B2 R, R e E “UDT20” 18—l
), STEP 7 HshHL o BN A6k 23 18]

ER— AP EXRERELR
J STEP 7 W LUE XL UDT. FEPs2 4 UDT, EW&LLRIoE:

AE AR E) . — NP FEERGEIR) . — D PR P EH). —
ANE B FAEABURE) UL R — AN SR AP AL T 45 R 5 5. AT AEESRT SR 4y UDT
TR — 554 (W1, process data).

Address Name Type Init,Value Comment
0.0 Stack_1 STRUCT

+0.0 Amount INT 100

+2.0 Original_data BYTE

+4.0 Control_code | CHAR

+6.0 Temperature REAL 120

+8.1 End BOOL FALSE

=10.0 END_STRUCT

-HATRT A UDT, AILAH UDT fEh— NSk AL, #illn, 76— DB(sfE—/> FB
1474 B 1) HR— 2R A PR I R 2 UDT 200,

TEIPR RN AL i process_data_1 (¥ DB, %48 i ({44284 & UDT200. M2
g5 UDT200 F1 process_data_1. 4%it¥i% DB I, S A RHMA I B 4 A4 B
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Address Name Type Init,Value Comment
0.0 STRUCT

+610.0 Process_data_1 UDT200

=106.0 END_STRUCT

AR P EXMEIREEE S EAE
ARG P 58 BRI R JC R IO, 5 BRI s S A 2 L
LG AT B, ArLAGr BE LA HIMe (Pl P I 2 SRR i )

Amount = 100
Original_data = B#16#0)
Control_code = C

Temperature = 1.2000000+002
End = False

WER T —AME 8 UDT, XA PIME 2Rl UDT W48 5 5t .
TEhEF0T B F P E X RYEUR R
AT LAY A —AS UDT 4aE—AN e . 7] LUE R &S5 ik (dn,  Stack_1. Temperature) .

7] LAFE 5B JC 2 A B 4ol i ik (40 4, 21 5 Stack_1 £7F DB20 A2 4675 0, Wl amount
xS DB20.DBWO ifif temperature /& DB20.DBDB).

FRAARPEXEIRREEANASE
nf LMEIEE A S0 UDT B i, WER—ANSEAEAR RSP S UDT, dfEis—AH
HHIFSH UDT. 129 H— A mHE, UDT M—ANesm el I ES — NS4
HZ UDT Wt 5 S5 B R BT

{F%ER UDT & DB B S

BEF— AU UDT, LU VT % BT AR S 4 S B, 4R T DA
S A (AT 55 AR 52

B, R—ANECOT (PRI )R iE— A UDT, o] BLEIXAS UDT $R 4 LA DB, 4
HA R

DB17 "DARK_BLUE™ |
I I I I 1
User-defined data type DB22 "LIGHT_BLUE”
— -
UDT1 “Formula" <
DB 23 "TURQUOISE"

Hn B 454 R e 45 € (1 UDT R .
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A3.4 BEER

B TIHEARE S HA R 2 Ah, ST LU R L8 IES 8 XS5, STEP 7 ALl
VDM S {E~tH

TIMER(5E 1) %) 5k COUNTER (ST 2#%) : 1X BLHR 52 HRPAT PR A — A5 52 1) 5 1 S vt
Bk WA TIMERELCOUNTERSHERAME AL S, TR 522t dh S — AN g I
B — A ERE, B, BN —ANR IR RS “T” o “C” .

BLOCK(#R): fg5E— A b Em NS . T2 5000 75 0 vk s 4 i By 2 7Y
(FB. FC. DB%). Wi ANBLOCKZH M SO B, TodaE — A HedhbE sk
Z. Bltn “FC101”7 (248 F 465 ik ish B “Value” (455 Hudik) .

POINTER(fg%): 8 —ANR bbbt FREFES—AHBEAZ — AN E. 98—
PONITERSE LM L S EE I, 2R € — AN HbbbE R SE bR S 4. ESTEP 7+,
A LSRR Ok S E — AN RER, T DR S A — AN bR EE 2 (W1, M50.0). LA
BEF A8 2T HE MAMBO.0JFUE B v LS 24 . P#MB0.0

ANY: X2 H T 525 B S BUOR SE o n] LR AT B 8B s I . BT fiRok
TANYZERBPELZMELR, TES% “SHRBANYRIKA” DLE “fiHSHE0
ANY” .,

ST /TR B 2EAL(UDT) . Ak UDT MEZEE 2% [ &
SCHIEHR SR i) $edhs

S5 BE A
TIMER 27 P /R AEAR R FH (1038 i B R 4 P () 52 1 3%
F T
COUNTER 2 T /R AR R FH (038 S B B A FE v H s
ki C10
BLOCK_FB 25 FRANLERE IR R e pi R e P (1 B
BLOCK_FC .  FC101
BLOCK_DB DB42
BLOCK_SDB
POINTER 67y Fri sk
Format: P#M50.0
ANY 1077 FHF 24 2 50 S5 28 3 R A0 )
#:  P#MB0.0 BYTE 10 B EANYHS =
P#M100.0 WORD 5
L#1COUNTER 10 BRI EANYH#
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A3.41 SR BLOCK. COUNTER. TIMER H9#&=

STEP 7 #2325 BLOCK. COUNTER #1 TIMER 1 b ik IBfEfE— NP (32 7). T

BT A IZSE SR A 5

Bits 15 8 7 0
lofofoofofofofo]oo]ofofo]s]o]]

Byte 0 Byte 1

SRV B 8 IR SRS I BORARYE S7 CPU ISRBNTMIE . /£ “S7-300 A% faf
Tl BT TN B “S7-400, M7-400 T gmARfshilas, AT e T it 8o
TR REM BN 2 5¢ T CPU REMSAE AT ROE N ds . THEGS O H LR T Dty B K H i)

o

A.3.4.2 S#ZEA POINTER MK

R R AR R A TR A A

Pointer format

15... 8 7. 0
Byte 2 Memory area 0|0|0|0|O|b|b|b| Byte3

Byted [b|b|b|b|b[b[b[b|b|b|b|b|b|x|x|[x]| Byteb

—

—

b = Byte address x = Bit address

O

ZHEM POINTER 7266 LA R E .
o DB A (i A A A7t e DB U 2 0)

o CPUH A7 A X BR(F 2 i A Z 2 POINTER AT filf D 173 Al AR

7 EFIR A Fh X iR

B#16#81 | LPNEEE

B#16#82 Q o HH X3

B#16#83 M A7 X 45k

B#16#84 DB EAG T

B#16#85 DI TR E

B#16#86 L SR (LR AK)

B#16#87 v AN F AL R s e

o Bl Ak (Y AL RS 30)
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STEP 7 #2454t 4% =X: P#memory_area byte.bit_address(P#17f X 45 71 A7 Huik) (4
RIES W S HA POINTER, RFEHE A X SRl STEP 7 £ A sk
NEEH O FRE A% ) o R AE T W 04 S N MB0.0 46 I Bl i N\ S $i 2k A
POINTER:

e P#M50.0
o  MBO.0(WIRTES B MIPOINTER).

A3.43 (FHS%ZE POINTER
B TR 10—l SR S0k 77 s 3AEE T AT DUZE R T B th 3 A s 5 )
f

BEH AT AR AT 0t

HIAF At 1) 1 - Ak A RE PR At — MR 4, — MBHEAR IR — M R 4Lk (2 i
WAAETT G5 e i)

KA I FRE 28491«
L | P#8.7 e BUESEN BN
T | MD2 FH8EHE AMD2
A | IIMD2] WAL, 7 M5 IR IFE HL
= | QIMD2] B S RERS HHA2Q8.7

fEE T XBAERA X3 X FHit

AP SRR R P12 MR RILU R 4L kbRl Mk %5 77 38 hn iR AT
fts . Hhk A5 A7 8 (ART/2) Ml B BLAA AR TT 15 5 A iR € o

Xig A ER T 1k 7R f51
FRE P AES A X IR TR R -
L P#8.7 e BUEZEN B g
LAR1 FEFRE BN gs 132 AART
A I[AR1,P#0.0] | &HIALLIS. 7R T IRAIH
= QIART,P#1.1] | {55 R AL H H47.Q10.0

fF% & 0.0 ANF2AEATT5Em, & 10.0 th 8. 7(ARN MW AZ & 1.1 115 H . 4554 10.0 1
AL 9.8, WIREHE .
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X383 X Fk w5l

A3.4.4

16 DA XG0k sp R FR R A7 X S (FE R R | R Q).
L P#18.7 BERAR AT DX Salbs VU B 381
LAR1 B AE A X I RS 7 FIART
L P#Q8.7 BERAR AT DX Salbs VU B 381
LAR2 B AL X IR QR 1S, 7 F AR2
A [AR1,P#0.0] | A A\{I18. 71155 IRZ&IE A
= [ART,P#11] | (55 IREM LS fr i 47.Q8.7

ImFE B 0.0 A=A 5em, 4t 10.0 H 8. 7(AR2)INmIE & 1.1 w543 M. 4552 10.0 A
9.8, WARER .

T2 sas AR

7RI FC3 “Routing Pointers” A LM& 2it— AN A7 bl B ik . *41% FC 4
W 35BS SRR A A B “Pointer” (T LA FH XUk 2 109 X8k P 350 X AT X
fa%h).

FZ40“ Bit-Byte "l LUE &5 A 571 kb (O A7 ki, 12 215 bdik) o A5 Inc-Value”
(R B0k )i AR P b b s 2 R BB .t mT DA R BRI Mk

SO L, S T I AR A (B DR L),

e P#Mb5.3, Bit_Byte=0, Inc_Value=6 => P#M®6.15}

o P#Mb5.3, Bit_Byte=0, Inc_Value=-6 => P#M4.5

FREF X 3AE BAZAZ I RE R .

FC #INFRE I L/ T XMIGOUTFREEAAL, A s “RET_VAL” (7] U R AL 2E)
BN 1”7 (HE TN FC3MIERIALEE) . X H:

o 1. fiHuhikgtE It Hinc_Value>7, Bi<-7

o 2 BT bR T IF BAS S iE A 7 L

IR R A e 8w SR 353 25§ e M | PR BU N 1 S 12

& E$TEY STL RAIER
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FUNCTION FC 3:BOOL
TITLE=Routing Pointers
/IFC3 W] ] T ekdast
AUTHOR: AUTICS1
FAMILY:INDADDR
NAME:ADDRPOINT
VERSION:0.0

VAR_INPUT



bR

Bit_Byte:BOOL://O:f itk 1: 75 Huhi:
Inc_Value:INT; /73 & (4 EE A A 57 = o/ N W SR E 8 1E => 38 1)
END_VAR

VAR_IN_OUT

pointer: DWORD; /B & e 454t
END_VAR
VAR_TEMP

inc_Value1:INT://r [ 2 &
pointer1:DWORD; /9 [al{g 54t
Int_Value:DWORD; /4 B2z &
END_VAR
BEGIN
NETWORK
TITLE=
IRZPARBCR a4 DI B 2
B A B h e st
SET /& RLO & 13fH
R #RET_VAL/E i
#Pointer;// ki i) A% FE AL A (H
#Pointer 1,/ [R{E 5 £
#Inc_Value:// gl i 25 B L5
#Inc_Value /7 [F) {5 19 &
#Bit_Byte; /W1 =1, 7T Mk 45 4
JC  Byte//kit B bk o5
L 7,/ Al >7
L #Inc_Value1l;

)

S #RET_VAL//E{L RET_VAL Jf H.
JC  End;/Bk%] End
L 7R <7

S #RET_VAL;//E /7 RET_VAL Jf H.

JC  End;/Hk#:3] End

A L 1.3 /AnFZERA 4=1(Inc_Value 1)
JC  neg;//MIBkEL A7k gk B

L #Pointer1;//L 2&35 £ HutiA5 2

L #Inc_Valuel;/in_ &

JU  test; /ML RN A7 EE R AR
neg: L #Pointerl;//25 3454 Hu:
L #Inc_Value;//2E 351 &
NEG1T /Xt i EUx
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A-44

-D
JU
Byte:

<l
JC
NEGI;

SLD

Ju
pos:

+D
test: T

End:

s IR A

test; /i 2R

L O/FiR=F T bk iz v
#Inc_Value://n F- 1+ >=0 N

pos;//EkE E ik, Al

#Pointer; /243 A k5 2
#inc_Valuel://25# 1 &

IR S AH IR

3/ ) A2 RS 3 A

s INREZHUA

test; /1B F Pk

SLD 3/ At — A

#Pointer /25 8 5 5T Motk A5 &
SN

#Int_Value; /G H 545 FAE 2 Int_Value.
L 7.3;//3n - ik e 2 R ksl o 1)
#RET_VAL;/W & A7 RET_VAL

End;//FF B3 End,
#Int_Value;//75 MIAE3% 45 1
#Pointer;//E|T5 %

NOP 0O;

END_FUNCTION
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A345

SHLEE ANY B9

STEP 7 JH 10 A~7-75(80 M) ATk S H A ANY .. Uit ANY SHCEM, TR
HEESHS Z S BN, DARRITE N 80 Mg i . #lln, wRfEsT
4 455E—A> DB S, EAFBLETT 6 HiEf E M.

STEP 7 X A AR & i S 7 1) B 5 S BRI 1 Bl AN ]

ANY &3 R EHE I E

I FEARIE A Bm A, STEP 7 17t LU 254l -
o HlEER

o WHARH

e DBSG

o DRAFAR B DX 45k

o T iA b

Data from elementary and complex data types
15... -8 7. .0
Byte 0 Data type Byte 1
Byte 2 Repetition factor Byte 3
Byte 4 Byte 5
Byte 6 Memory area Byte 7
Byte8 | b| b|b| b| bl b|b|b|b|b|b| B| | X| X| X| Byte ®
— A
b = Byte address x = Bit address

ERAMARY M SHER ANY IR B R B . KW P DR E M
a3, I H B R GE A S S 5 ANY 3&EHz: . STEP 7 X502 R S5 Ky A4 g LAy
B ORI (R R BB ) Biltn, W2RE4R16 10 N7, AU 20(7719)
ENER R

HHE UL 755 A (KA sCAE i, P P A 7 I O e 2 00, FHT 8 I O 7
PECA R 9 K 3L 7 Ao A HUHEAERETE T O 1 O A1 % 2 .

XA NIL (48, T3 1 THAII T 75 #8IRAE R 0.
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RIS NS HIEE ANY K8 5 CPU (% S 45 o

A-46

RWAvinikL HE AR5 U

B#16#00 NIL Null pointerz5$5 %t

B#16#01 BOOL Bitsfir

B#16#02 BYTE Bytes(8 bits) 1 (8f)

B#16#03 CHAR Characters(8 bits)#4F (8f)
B#16#04 WORD Words(16 bits) 7 (16{)

B#16#05 INT Integers(16 bits)i&$ (1647)
B#16#06 DWORD Words(32 bits)7 (3247)

B#16#07 DINT Double integers(32 bits) X3 % (3247)
B#16#08 REAL F A (3261

B#16#09 DATE Date H

B#16#0A TIME_OF_DAY(TOD) | Time of day H 4}

B#16#0B TIME Timef ]

B#16#0C S5ETIME Data type S5TIME 4 S5TIME
B#16#0E DATE_AND_TIME(DT) | Date and time(64 bits) H JIFI ] (6447)
B#16#13 STRING String 7 4F #

RWAvinikL iEAERI47T iR

B#16#81 | LN

B#16#82 Q X

B#16#83 M PEAEAEIX

B#16#84 DB EAG TN

B#16#85 DI GRS

B#16#36 L Ja I (LAR)

B#16#87 AN R FH AL R s




Bry=%

ANY BB SR

STEP 7 WS HAUAHREAR M S Hhdl. EE AL 1. 7974, M7 B2 0,
T8 9 FE I g THEE RS .

Data from parameter types (timers, counters, blocks)

15... 87 .0
Byte 0 Data type Byte 1
Byte 2 Byte 3
Byte 4 Byte 5
Byte 6 Data type Byte 7
Byte 8 Number of timer, counter or block Byte 9
NERFTR A SHESA ANY R
HelE T R4
N HERA Ffla R Eiip
B#16#17 BLOCK_FB FB5 4%
B#16#18 BLOCK_FC FC=1g
B#16#19 BLOCK_DB DB 5
B#16#1A BLOCK_SDB SDB514
B#16#1C COUNTER TS5
B#16#1D TIMER E I 455

A3.4.6 (ERASEZEE ANY

A LA BGE MBS AR AR R N5 S o g i I AR AL 52 2 M 5l
A TR AT 22 (¥ (L S SOV AR R R I, X Fh DD eRe AT o AEBR AR B
A, AT SHO B ANY . SR51E STEP 7 ] DU E AR S A L ) — A
K2,

STEP 7 24 ANY $udi R )22 & 73 E 80 MLAIAFHIX o W FHs — DL S ME L XN B S,
STEP 7 4S5 S (e an ik . KRR B2 G i 713X 80 M rf o B AT KIS BT 3K
A ANY ZELITAF Gk 1 80 MK, BRAFE DA BT IR

HE—IRBH— ANY S5

WER—ASEEAR AL ANY, AT PASY i —AME R B R AU SE S48 XA B S 1F STEP
7, AT RAHRE DU N ER R AR i S

o EARHIRAA. v LIIRE XA LS WA HIME BT S 4 .

o EAHINRE. WTEGHINRB (A M) BB e T 4.

o JENEE. THEEMRIE: dRe S (h, T1, C208LFB6).
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P e i A T A3 2 AN HE SR ANY 2301 FCo

FB10 |  with DB10

Variable declaration

|
|
STAT | Speed | INT |
CALL FC100 FC100
in_par1 := #Speed
in_par2 := MW100 | i Variable declaration |
in_par3 := DB10.DBD40 \;;\\IN Tipen 0 AW |
= L
IN | in_par2 | ANY |
FB11 |  with DB20 1T [ Tinpars | ANY |
Variable declaration i).f
TEMP | Thermo |ARRAY[1?{
| | REAL /|
</
FC100 [
#Thermo = in_par1
M13 — in_par2
T2 — in_par3

LEAHIth FC100 H =42 3(in_parl,in_par2 LA in_par3)#¢ 75 Bk ANY 257,

o Y4FB10WMFCI00K, FB10fEik—MEH(HaAL Hspeed), — M F(MW100)LL K —
AXUF-FIDB10(DB10.DBD40).

o HFB1TIHHFCI000S, FB1MEIE —ASEEEAL (G4 & “Thermo” ), —AMa/K{E
(M1.3), BAS—ANE I #3(T2),

A= ANY SHEE — MR XE

A48

AMLATRAZE —A> ANY S8 E — NN E (], MW100), i HAs ] LAE & — Al
DXt ARARSR E — A XA N SE S, AR B H Bk 2 A% 3% 10 Bl 1

P#  DXERRIR P AL Bl EEARH

T B R, wBL L B A% XA € P A R R AR B 8 R B Al R
DATE_AND_TIME. & EATUAJE BOOL, i Hihik 22 e 0(x.0)e FREX =A%
AORBIRBEH], Xk U TR LIRSy A ANY SELRAT fif DXt

£ ik
P#M50.0 BYTE 10 FEF AR DR B 104 70
MB504MB59

P#DB10.DBX5.0 SETIME 3 | 452 = Mir T-DB10H e 2 g
SETIMEf{%#F #47: DB 1164 DBF 1510

P#Q10.0 BOOL 4 R X g e 447 : Q10.08Q10.3




bR

ERSEZER ANY By

T A An AT 4 S B8 ANY TR S fig SFC20 BLKMOV & ifil—AN 10 S5 A7t

(X 45k
STL

ke

VAR_TEMP
Source : ANY;
Target : ANY;

END_VAR

BEGIN

LAR1 P#Source;

L B#16#10;
T LBI[ARI,P#0.0];

L B#16#02;
T LBIAR1,P#1.0];

L 10;
LWI[AR1,P#2.0];

—

22;
LWI[AR1,P#4.0];
P#DBX11.0;
LD[AR1,P#6.0];

= r— 44

LAR1 P#Target;

—

B#16#10;
T LBIAR1,P#0.0];

L B#16#02;
T LBIAR1,P#1.0];

L 10;
LWI[AR1,P#2.0];

—

33;
LWI[AR1,P#4.0];
P#DBX202.0;
LD[AR1,P#6.0];

—r = -

CALL SFC 20(

RET_VAL:=MW12,
DSTBLK:=Target
);

END_FUNCTION

FUNCTION FC10:VOID

SRC BLK:=Source,

1 ANY BRI IR AR,

HeRBARIEARR(ID)IF H.
%y ANY JRE

B IIL A IF HL
%y ANY JRE

P10 A HL
%4y ANY JRE

Vi & DB22, DBB11

Hei ANY FREF R IR AL R] AR

AR LA R(ID)IF H
fhikeh ANY fa4t

PR HH I A I H
%4y ANY JRE]

10 IR H
% ANY JRE

H#5/2 DB33, DBB202

W R G BLKMOV

PEAL BR AR MW12
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A3.47 AZERAEEEERE EHIELE
iiH STEP 7, TEYUREFEII, 3Beas RBEAR IR R (A S SRR D R S
M) A IER .
OB g #E 8B R LB
TRV A OB H R W RE(—). BT AR OB, ikl OB & H %
HimoA s/ ). T OB WA & DB, FTLIAREN OB FHI{TMH&ZR. OB
VIR P 2 ) B0 DI TR T DA B AR 1) 8 52 4 PR B 2R 70 DA B i 257 ANY
AR S « 2R,
FERER | EAEERT | ESHUIREE | SKERE | SEEED | SRR | SEEE | SEEEE
TIMER | COUNTER | BLOCK | POINTER ANY
Input — — — — — — _
Output — — — — — _ _
Infout — — — — — — _
Static — — — — — _ _
Temporary o aE _ _ — _ D
1) A FOBRLMERH
FB B iR r B MBI LR

RGN A FB U I RAE (). TS DB, Oy FB IR e i
SEMIPREMR D U A SN BT IRGE s 60T — Mt 288
R, TR TN ZEUT VI 2 HE T

IS N

ap =k

RE 7 AT Ae) S 402K
5 POINTER F1 ANY . 7] LL A B il I 48 & ANY

(3) FFrH

BB, R S B E AR A .
AR NS « Fomo
FEZEA | BEAKUERR | ESKUEEE | SHRE | SKER | SHER | SHERD | SHER
TIMER | COUNTE BLOCK | POINTE ANY
R R
Input
Output — — — — —
In/out S — _ _
Static — — — — —
Temporary . @ .2 — — — — .2
(1) A28 SR A 225 (48f i k)

(2) AT FBINLAER T .

[ =

/\ﬁb/—sEXy‘Jiﬂ%\{/t}Eo
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FC BB AR E

TRUH A —A FC A RBEHR MR (—). T FCHAL = DB, iLlekaTHEEL
=, T FCH%A. AN / HS5 A S5 POINTER A1 ANY J2& ftiFi. ]
PLA B I AR 80l ANY S350,

ABIRENFT S« &oro

HERLR EAKUELR | SEHIERE | SHEEE | SHER SHLR | BHER SHELR
TIMER | COUNTER | BLOCK POINTER ANY

Input o2 . . . .

Output . — — —

Infout .2 — — —

Static — — — — — — —

Temporary - -V — — — — .

(1) A TFCILIF HER
(2) FAre R RgsE ORI KB

A.3.4.8

2P IR (851X S 00T 5t 15 B ER 2R

BFRZESHEENRN

MG SIRE SN, 1R E — AN NS 2 s — A E 4. STEP 7 A A2
HOBR A RN EL . B0, A H R N/ 2 RS RERIER A (DR 0 fi ) N 2 5
(1 H RS 2 R e ) . IX LS PRE R AN T R A BRI S A, e TR
REF 72 4] bkt AN BE L 5L

RGP 2 SIS I ER R I BRE

AL S« T

EARKIELR
LI 2055} H - R g (ERFSERT) | IR g
Input . . . .
Output —
Infout .

SEEHEEE
L 2055} Ho il DBILHE MK 54 I I R 5 ik
Input — . .
Output — —
In/out —
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Ihie (FC) iAThEE (FC) BTRYB AR LR

AT LU M FC BTG ZIE S — AN BT FC G S . R EBLBI FCI10 RIBESHE N
SBMEL FCI12 L 5.

Function (FC) Call Function (FC)

FC10 | FC12

Variable declaration

Variable declaration

Param_1 Input ~ .. A_Param | Input
Param_2 Output " B_Param | Output
Param_3 Infout C_Param | Infout

A_Param := Param_1
B_Param := Param_2
C_Param := Param_3

|
|
|
|
Call FG12 ‘

STEP 7 X T4 —A> FC KIESAE WL S WIES 73— FCIITESAE T g, B, AREHs
ERERCTENINE S C e S CUTH P X =

RPN A FC A 73— FC I et B R - ).

FRAAZEE! HEAKE | EEKUE | SHEE | SHE | SHEE | SHEE | SR
el EEI
TIMER | COUNTER | BLOCK | POINTER ANY
Input—Input . — — — — — —
Input—Output — — — — — — —

In/out—In/out — — — — — — _

Output—Input — — — — — — —

Output—Output . — — — — — _
Output—In/out — — — — — _ _
Infout—Input . — — — — — _
In/out—Output . — — — — — _
Infout—In/out . — — — — — _
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Ihiesk (FB) AMTHAE

SBREL FC12 MBS

(FC) BTRYB &R EY
"L — N FB BB

W2 — MR FC IES

A_Param := Param_1
B Param := Param_2
C_Param := Param_3

Function Block (FB) Call Function (FC)
FB10 | with DB10 | FC12 I
Variable declaration | Variable declaration ‘
Param_1 | Input | ; A_Param ‘ Input ‘
Param_2 | Output T7 B_Param l Output |
Param_3 | Infout | C_Param | Infout |
Call FC12 ‘ ‘

STEP 7 X FK—A FB KIJESRAE % —A FC KIES

ETIRGE. Flan, AR
ZHAENTE S TR A —A FB A —A FC i AavFm s 230 (

o NEULHIK FB10 ) EZ

B BHR
)

()

e EANE | EANE | SHER | SHER | S5%E | sH%E | sH%R
il et
TIMER COUNTER | BLOCK | POINTER ANY
Input—Input . — — — — —
Input—Output — — — — — — —

Input—In/out

Output—Input

Output—Output

Output—In/out

In/out—Input

In/out—Output

In/out—In/out
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hEE (FC) ARThRELRET BB SEERL R
AT LK — /N FC ITES ML — MM A FB MBS . T FC10 ITESAE A sk
ZIREY FB12 BB

Function (FC) Call Function Block (FB)

Fc10_| FB12 |  with DB11

Variable declaration Variable declaration
Param_1 | Input ““_A_Param | Input
Param 3 | Infout C_Param | Infout

Call FB12,DB11
A_Param := Param_1
B_Param := Param_2

|
I

Param 2 | Output || 7/ B_Param | Output
|

C_Param := Param_3 ‘

STEP 7 X§#—A> FC BB —A> FB ITESAE T M. B, AGEHs 5 & Hda 2K
ZHUE RIS (A2, ATLLR 28R, TIMER. COUNTER =¢ BLCCK HJ4i A2
B e M FB A S H.

FRFTR KA FC A — FB I RVFAIEE A - ),

L] EALE | EAME | 5538 | SMEE | 3HED | %D | S5
EEI il
TIMER | COUNTER | BLOCK | POINTER ANY
Input—Input . — . . . — —
Input—Output — — — — — — —

Input—In/out — — — — — — —

Output—Input — — — — — — —

Output—Output . — — — — — —
Output—In/out — — — — — _ _
In/out—Input . — — — — — —
In/out—Output . — — — — — _
In/out—In/out . — — — — _ _
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ThAER A FATh RESR AT HY B S B0 HE 26 B

A LR AN FB MBSt 4 MR FB. N EBLI] FB10 (KT 241 4 e 2l e
4 FB12 (2.

Function Block (FB) Call Function Block (FB)
FB10 | with DB10 FB12 | with DB11

Variable declaration Variable declaration

Param_1 | Input .\ A_Param l Input
Param_3 [ Infout

Call FB12,DB11
A_Param := Param_1
B_Param := Param_2

|
|
l
Param_2 [ Output Lr e /B_F'ararn ‘ Output
|
C_Param := Param_3

|
|
|
|
C_Param | Infout |

STEP 7 Xy T4 —> FB KES IS 73— FB KIIESAE TRRE. Bt s E a8
A N S8 D S IRAEAE poR AT ) FB AR A RIS . (HE T LU S R Y
4 TIMER. COUNTER =k BLOCK i A S B E45 B I 1 FB (A S5

RPN FB A 5> FB I S B R - )

FRRAZEERY HEAKE | E5HE | SHEE | SHERE | SHEE | SEEE | SR
% el
TIMER | COUNTER | BLOCK | POINTER ANY
Input—Input . . . . . — _
Input—Output — — — — — — _
Input—In/out — — — — — — _
Output—Input — — — — — — _
Output—Output . . — — — — _
Output—In/out — — — — — — _
Infout—Input . — — — — — _
In/out—Output . — — — — — _
In/out—In/out . — — — — — _

A.3.4.9

BT RERAY IN_OUT SEEME X

ARSI ALR S Th RE P FB) 1 IN_OUT S 4uh, ARt iy bk gl AL 1% (12 % H) .
MILAYE RGP R 2 — DI REP) IN_OUT SN, 7Eie ) D gl < i B 4 52 1 5
AR, D REH AT R R SN SR S DR KRR FE A SR 1 IN_OUT
A ] LN EEAT AR, (B, AR R ASRER] — AN B se 240 IN_OUT 424,
PR ANREXS — AN 8 B S 1A
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A4

A.4.1

S
>

A-b6

i STRUCT sk ARRAY A B AN REBAIAGAL, PN IZAI G DL TS St A
— ANk

fEMIAmET1E

SEIRARZS 1 RYILE

St FAEH STEP 7 BiAS 1 4B H ol VBRI . infRxes, DAUKARA 1 B30 H
A 2 (5 H .

KA 1 BI50E DR 2 ] LAGR B

o TR I H 45

o

o STLUE

o fi5

T AW, AR HIXANTH R RIH e I H . 38 0] A7 I H
AN I e 4L R S HURAE .

— BUSERRRAR 2 (A, 3 AT LAFE— AU HE A ke S8 IR A 77 B IR A 2 (1) I H 5 4
9 MHIRA T STEP 7 B30 H o

EFln

FABAD R RRAS 1 SRV ST AR 1 AR A S BN, RILARGEYE ok
U EA LS

L SR AR AR e e o R () e 7R B 22 L 5, 1 SEAE A LAD/STL/FBD: Programming BlLocks”
I FH RSy 2 i R R 2B e STL YR SCAE, AR5 5 9t RIS SC A A2 OB R B AR R A R B
MFEZ I FUE STEP 7 JRAS 2 (Mg tE, FICUERRINREL(FB). Wi R ARLERCA 2 (I H
R ke 1t 7 AR ST FIAERRAS 1 b A2 figtl, R EHeeq].

TEREAA 1 IIH 4%l N AT
1. IEPEEHLAT4 File > Open Version 1 Project

2. FEHDLRRT AR AP P B RROAR 2 I H , w DUE I AL % s7a SRR 1
K3 H -

3. FE N ASXTEAERR, CHRRA 1 B H S ORI AL T
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Ad2 FEREAR2I1H
1E STEP 7 i mT LLH 32 H iy 4 File > Open $TFFhAS 2 1930 H .
As 2 10 H /ZE T DA R (T B ) 2R a1 STEP 7 hiAs o fif 2% #1454 File > Save As
FriE kI~ Rearrage before saving(f7-fifi BT B HT#EHE) 7, X IUNBEAE A 2417 STEP 7 iitA
TH—ATE
AT LAgmAEk 5 IHY STEP 7 RRAI B FEEFHLRFFEA 1M, H HAE “Save Project As”
XTUGHEH IEREIH ) STEP 7 FRAE N AR SO BL. lhn, ZE4i%s STEP 7 hRAS 2.1
FIA %, X Bk “Project 2.x” 5% “library 2.x” (ANTATHER 5.1 LA IRIRRASTEAE R RRCAS 2,
AT LS 2 G AR 2 10 H FIED o
XHLEIRE
STEP 7V3 MSTEP 7 VAT &
MR IRAS I SR Project 3.x Project
Library 3.x Library
IHRRCAS R S AR S 2 Project 2.x Project 2.x
Library 2.x Library 2.x
XA A e —JE N ) STEP 7 IHMARILIRE. (HJEAT LA4kEEH IR STEP 7
AR B AL I H D
R’R
MIRAS 3 TR RIRA 4 J T i R ROAS Rs B 4 7 AR Ak s B XATS R R — 3 BRIk TE STEP 7
V4 FAAFAESCAFSEAY “Project3.x 7,
IR

K RRAS 2 1935 H #4509 241 STEP 7 FRAS (A% =X al 42 R 3E4 7

1. 7E File Z2HH A% HPAT “Save As” 4L “Rearrange before saving” 1.
2. 1E “Save Project As” MGHEHELE LAY “Project” Jfriili “Save” %4,
SRR 2 (3T H 249571 STEP 7 WA [ i ZELRFF e ATIA% X, W M AT

T WA B ESATLL B,

2. 7F “Save Praject As” MAEHEFEREIH K] STEP 7 JRAS I SO 3 iy “Save” 4.
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A43 XEFSTEP7V2.1TEER GD BREYIETR

o  WIRIE AT A BEIEMSTEP 7 V2.1 H #4444 STEP 7 V5, B 4C{ESTEP 7
V2 11935 H FFISTEP 7V5.04T JFGDR . LARG T 4L A% 0 38 VA B U5 (8 i G DIl v I A2 e
H Bl 3 B 1 4k

o UAFRY—ANSTEP 7 V2T H N, Wi m H b S KT ) \ANFR SR, THFE
JP(ARJ, PKZIP-++ )&k H— ARG S . WERBEGnHISTEP 7 V21300 H H [ MPI R 2%
AAKT8MERHIDER)IN, B HIUX AR ER . 68 KA s &2 R E
G20, AEAEREINSTEP 7 V21T H ', AMPIMZ4aiE— MBS E/F KM
YT

o WIRBEHK—ANSTEP 7 V21 H 4, WMAAEGDRMIFRIAL(CPU) it 75 vk £ 24
MICPUKEHIRM . R IHMINE 4, SRR RSB TR TR,

A.4.4 DP MuhER GSD X sk GSD X B HbE

Wit STEP 7 V5.1 AFE LT LAk, g2 2k DP Mk GSD SCHEL, BRANfeSn i
GSD 3CfF (fn T GSD S h A i 4 )

FEXFPEOL R, STEP 7 AEme—A “ MM A ARACR BT 4L as (K i, Bl — Aok s
B2 A 2 b BT T I H $ATEE 2 AL BE . % “REfBC Mt RO BR AL B, ANRERE
M g5Hy (DP ARIRFT) AR BESH . Il A A IR Bt m] LUBN R AN Ml

E#73f DP Nt HSHFRES LK

WIREXS DP ST E TS S EORAE, 220 3 B A St i GSD S Jfidad
Options>Install New GSD #7235,

FENIEWSCAT G, ek DP Mufic b DP b 605 7 priss Edls,  JF nl LA JLdEAT
AbEE
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A5 TRBIFER

Ab5.1  REIBFIRBIREF

23 CD T EVELRHII H . 76 SIMATIC Manager 1) “Open” SfEHE A1 7] LLHE 2 £
B o 2422 WAL I ] BEIE S H e R H o A X LRI B E B S
D36 I AL (R BERL
SHIFARGIE B BIEFECDH | EASZHERIA | OB1HAYILAA
“Zen01_01_STEP7_*"to “Zen01_06_STEP7_*"1ji . EA A
H (ERATIMZ2D
“Zen01_11_STEP7 DezP"Jii B (PROFIBUS DP41%
S
“Zen01_08_STEP7_Blending” 35 H C TNVEE S
“Zen01_09_STEP7-Zebra" Wi H (B LAz ilf5 55
D)
“Zen01_10_STEP7_COM-SFB"3i H (P4~S7-400
CPUIH] I BHAZ #)
“ZXX01_14_Hsystem_S7400H" I H (4 A& | - AT
B H >
“ZXX01_15_Hsystem_RED_IO" T H G TUARNO¥ A | - b RS
IIZEH R sh I B D
“Zen01_11_STEP7_COM_SFC1”
F1 "Zen01_11_STEP7_COM_SFC12"3i H ChIARH A
)34 39 T B TS F CAT B iedls )
WiH “ZEn01 13 STEP7 PID-Temp”
({fi FIFB 58 FIFB59HEAT I BE 5 il ih 7 451))
ASEH e RS2
AR i) F2E 5 R T S
7 W P T e [ 0 i 1) 512 481
A RO BB BT S S R R 14 S48
PP TR S0 R 1) S SR A S

B I A R e b B A R 76 IO B o AT A, S50
AR B8 AL AR 025 9.

HBRFN % 1R M A0 R BIT B
SR B H AESIMATICH B G v ol LRI KR, AR5 10T LU 223 B2 2B H
WAEHSTEP 7 V5.0 2R8>, 7Bl H 1 T DL IR Ji5 2e2ke . ml LUK R AL R il 72
e P I R B R P A IS i 4 Save As” 476 0 L I H
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=R

e STEP 71, BRAFRE G A ftitzn Bl i H o R O ftmzn gl 5 4F 7
i, WIXLLBEOL R HAE STEP 7 BUBT 2RI s B i . ik, NAZAEARAE(TE
T R AR PR B . SRR R I H g

Ab.2 T IR TRGIREF

ATRGIRE AT K 56 T F i — A LB R R B T RE CAEA T 3 — b sl

%

PIAECEHECRE A MIECREE B)FE— MRS HET i BEHE sl S e . RE I i —4
HERHEHE R s AR AOHER .

Area: Ingredient A

I
s Py Area: Mixing tank
2:i by

Agitator motor

Inlet Feed Feed Flow

valve pump valve sensor @
Switch for tank
level measuring
oo
Area: Ingredient B
—
D) oo
O
Inlet Feed Feed i -
valve pump valve Area: Drain
v
A
Drain valve

378 h & AR fiA
TS 8L T TR o Ly Th R BRI AT 25 R o TS %
AN
RUEL A X FTRCEL B X
o RERIRRM AT A AN LR AR B B R 5
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RIS

o HERMEILA TUEAL G

o CUBERBIEAL KSR R RERE N, PR A RS A BUE -

o CAFRRIRAT T I BERR K5 3L S BUE -

o (EEBIHERE S R IT A0 K VRD B A A 5T TT N 1T IR RIER} R o

o FEHERIRIE A OR B WAL (005 ) BT T2 2007 B OC AT LARIT PO AR it %

o ERERINAZNS AR S F, WATL AERR SR N7 A, iRk
SRS SR i

o CHIEREITING WERGR ARG BAT TR T, WER AU AT REPR LT TT .

o BERLE A SR BT V. (YRS )R

R
o CHREIRCITE R T BT SR IR, SR BLI R B A
B .
o B LR BB S WA . R U BLR B 1 OF IS
BAL S, LU T
o DGR BEHE L BLIY B KR AT TR )
o TEIRA ML AU =AM I
S R B R RN, AT
ST RN MR AR, A
SRR ETTR, WREERES, A4

HPELX
o GEAE IR Eh— DNRER A IR A
o IXAMRAEINNTERAE DI, (FRIRRAE “CHER” 55 RN, XA
o ATTFHERHRLARBGE, 2
- PR T AR
-

AR —ANMAE R BN AR R, RN RS R RS DU S

o HTESIIENREZENEMITR. £/ “reset maintenance display(SE 7 44 B 7R)”
TG, ALY BoRAT, SN v 4 R R b 0.

o FRAREFRRAN ERLT

o ESEHLITFR.
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A5.2.1 ENBiEHR
AT LR P FE 7 A7 BN R (R e o 9 7 B 16 43 /2 S5 MRk 5 MU AL TR T
BRSNS BE
BT R G R AR R T R 1 23 2 R B 2544
OB1 DB1
WEEREA L | p| FLHA
) ™~ FB1
T~ DB2
SR RORIB p| WL P
/ ................. »
DB3

A-G2

T T e

HEFHRAIB AT
FIFFH

................. » Bk B

\v/

OB1: LCPUBAERZHILI, W& EEM)F. fEOBTHIHAIRFBIAFCT LA #
IR I A A E S

FB1: BCRIARIZERER . BORHBAIRERR AR LA T 0] th T 2R — B . T
THEON REAE), B EARTE I ) A h RE B AT .

HHDB1-3: A THEMINCEIA BORIB PR A BERE ALK 5 2 K A Bl 5 A I,
PR3 S A E S FB TSR I =N DB

FC1: BCRIARIBII I R AIE R LL A HERH I C [ A — AN e, il T H i gl
“YOTAMS” Thig, —FCHALR T .
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Ab5.22 EEFEH

FERIRR PP T 455, XA S ZiH] STEP 7 7ERF S R g o N R A T HIFE

PR IS 5 44 K diont ikt

BERIZR . B AL O i B0 5 S sk

S ik HiELE 1t R

Feed_pump_A_start 10.0 BOOL JAENBCRIAT 3R 4
Feed_pump_A_stop 10.1 BOOL {52 (EECRLA R 3E R 2R

Flow_A 10.2 BOOL BB AT S

Inlet_valve_A Q4.0 BOOL EE R S PN
Feed_valve_A Q4.1 BOOL JAEhECREAT 3R] R
Feed_pump_A_on Q4.2 BOOL “RCEAMBERIZIZAT” FRonk]
Feed_pump_A_off Q4.3 BOOL “HURPARIERASET” JHmAT
Feed_pump_A Q4.4 BOOL BORLARIBERIE Ja 3
Feed_pump_A_fault Q4.5 BOOL “CHEREEARE” FroRtT
Feed_pump_A_maint Q4.6 BOOL CHERIEAYEY FeoRAT
Feed_pump_B_start 10.3 BOOL Ja ZhECEB I kR 22
Feed_pump_B_stop 10.4 BOOL {52 1B I 3t R 22

Flow_B 10.5 BOOL BEIB AN

Inlet_valve_B Q5.0 BOOL JAENERIBII LR
Feed_valve_B Q5.1 BOOL A SR B ) iR
Feed_pump_B_on Q5.2 BOOL “HEBUER SEETT” HhRAT
Feed_pump_B_off Q5.3 BOOL “RCEIBMIBEREREARIZAT” Faont]
Feed_pump_B Q54 BOOL Ja ZNECEIB kR 22
Feed_pump_B_fault Q5.5 BOOL “HERIEB IS FeoRkT
Feed_pump_B_maint Q5.6 BOOL CHERIEBYEY” FeoRAT
Agitator_running 1.0 BOOL ey INL BN ER=
Agitator_start 1.1 BOOL Wik o shigdl

Agitator_stop 1.2 BOOL PiREE 1

Agitator Q8.0 BOOL S B

Agitator_on Q8.1 BOOL “PREESSIZAT” FRoNAT
Agitator_off Q8.2 BOOL PR RIZAT” FRoRd]
Agitator_fault Q8.3 BOOL “PrEERALERE” FeonkT
Agitator_maint Q8.4 BOOL “REREERMLYEY FeodT
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& RER FNEERE T Y75 S ik

4 kil HiEAE 1% FA

Tank_below_max 1.3 BOOL CTRETERDG” fR 8%
Tank_above_min 11.4 BOOL VR A TEOHE T A PR 7 AR g
Tank_not_empty 11.5 BOOL RATEIET” fRIRA
Tank_max_disp Q9.0 BOOL “YRETEMW” FRaNAT
Tank_min_disp Q9.1 BOOL WA TERIAR TGP $/R KT
Tank_empty_disp Q9.2 BOOL “URETER” FRaNAT

HERL R BY 7S ik

e buichils IR 15 AR

Drain_open 10.6 BOOL FTIFFIRHE fr 4241

Drain_closed 10.7 BOOL J& PAHER ] (1) F2 4

Drain Q9.5 BOOL Ja shHEE R

Drain_open_disp Q9.6 BOOL “HERM®FTTF” $8754T
Drain_closed_disp Q9.7 BOOL “HERHR I ” FroskT

HeERZAHHT S

HeR o3Ik HIELER WEER

EMER_STOP_off 1.6 BOOL BB TT

Reset_maint .7 BOOL AT ML 4E s kT T2
Motor_block FB1 FB1 PR ALY FB

Valve_block FC1 FC1 PR T THIFC

DB_feed_pump_A DB1 FB1 LR IEAR TS 5:DB
DB_feed_pump_B DB2 FB1 IR REEB I 51DB

DB_agitator DB3 FB1 P il R AL 5:DB

Ab5.2.3 ERHEHH FB

% FB IER 21T 47
HIHLIY FB A 46 LA R 8 4 Ih ik
o ATRABIFEIESIAN .
o RVFRABRAER—RI LB CEMBHE RN . FBURZSAAEEOB 1 I I e s A (LHE
F)th( “Motor_enable” , “Valve-enable” ), Jf H. 24 FLHLIK FBHR AL HLIN 55 55 B A0 11

MANHATZEA S .
o R A VR IR B ANEFE (N R A B, A B AT i b sl it L. %)
AENI {5 L.

o I R) AR S92 i) A 5 R A A 2 ) S0 A i

A-64



bR

o MBHIIEM,

(1 Wiy A 5

$5 T N\ F0EG
NPt AL FB A A o

WA B A R OF AR RS, e BAT RGBT H 24 ML L.

—ANE N AR BIEAT, WRAE SE I 5 I R BA 2 B R B Bk A B

s UL,

Start
Stop

Response

Reset_Maint

Timer_No

Response_Time

Motor

Motor

Fault

Start_Dsp
Stop_Dsp

Maint

ENX FB HIBH

WAy L T3S A R L 2 T 5 FB,
AT 7=l R (B ALE FB /5 22 LLR %5301

EUATR ARSI
B K B HLAUR AR A
EAA SR R B LA S B W AR 5 R IR Ao 1 SRAE T
ST g A5 5 JU) AL A 23R T o

A RE I BT A ol _E KRR IT
e —ME SR L.
REER AT AE O FB A o NP A AR Bl R L) FB 24

AT LU 1k B B LA R
5 LR R BALAEIEAT .

WAy i N S SCE TS 04

I E) P B

SHE

A

Mt

A/

Start

Stop

Response

Reset_maint

Timer_No

Response_Time

S|

Fault

Start_Dsp

Stop_Dsp

Maint

j I e i o i e }

Motor
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HEHK FBERTE
WA AL FB AR f A/ B

ik 1] TEZR i) #MiaE
0.0 IN Start BOOL FALSE

0.1 IN Stop BOOL FALSE
0.2 IN Response BOOL FALSE
0.3 IN Reset_Manit BOOL FALSE
2.0 IN Timer_No TIMER

4.0 IN Response_Time | S5TIME SET#OMS
6.0 ouTt Fault BOOL FALSE

6.1 ouTt Start_Dsp BOOL FALSE
6.2 ouTt Stop_Dsp BOOL FALSE
6.3 ouTt Maint BOOL FALSE
8.0 IN_OUT Motor BOOL FALSE
10.0 STAT Time_bin WORD Wi#16#0
12.0 STAT Time_BCD WORD Wi#16#0
14.0 STAT Starts INT 0

16.0 STAT Start_Edge BOOL FALSE
FB A Hvth . SN/ A AL AP RR € M1 5% DB b, I AR B At /e L o
o

A B H 412 FB

76 STEP 7 ™, 4 — /M Ak — & BAE U e MR Z AT A= . IRIRAE 7R RE e PR 0 20
1E OB1 Z Hi A sl LMK FB.

{7 STL g B2 =10 FB1 BT 3820 1

Network 1 Bai/Z1EFn$iTE

A(

O  #Start

O  #Motor

)

AN #Stop

= #Motor
Network 2 31z

A #Motor

L #Response_Time

SD  #Timer_No

AN  #Motor

R #Timer_No

L #Timer_No

T #Timer_bin

LC #Timer_No

T #Timer_BCD
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A #Maint
JCN END
L 0
T #Starts
END:NOP 0
EREREIER
RHEPERE “FB17, NEIE 482 4 FB1 1K
Ab.2.4  AMEITERK FC
% FC MEXR 2+ 4?

A #Timer_No

AN #Response

S #Fault

R #Motor
Network 3 BE1{E RATFASIFE S 1L

A #Response

= #Start_Dsp

R #Fault
Network 4 BiFF$8 7R KT

AN #Response

=  #Stop_Dsp
Network 5 Bahit41

A #Motor

FP #Start_Edge

JCN lab1

L #Starts

+ 1

T  #Starts

lab1: NOP O
Network 6 4E3P45 7R KT

L #Starts

L 50

>=|

= #Maint

Network 7 £ RiT /2 shRE AT 4125
A #Reset_Maint

WA BHITFRIXITFTIT . 1E “New Data Block(#r £l ) ” X 1 HE i £ 35 “ Data
block referencing a funtion block(Z [ —ANThagbME Iz L) ”, & “Reference(Z7%)” %

EINEN
[EB

XA L ATHERER LU PR ) D et 5 LU R 2 fg:
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IR Input Output In/Out
Open v
Close v
Dsp_Open v
Dsp_Closed v
Valve 4
BTN H

TR IR EH FC AR . T FB AR RS, WA FC IR
IR [Fly 24

Open Dsp_Open

Close Dsp_Closed

Valve —
Valve

o —AMHTATIFRITHEA— N TRATTRHA .

o OBV AT IT . IR AAAH AEOB T I i I Rk e s (LHEAR) 7 (“ Valve_enable )
IF HAE IR THI FCHAL PLIN 54T PRI A 5 AT 2 A & .

RPN kRS FC KIS HL.

AMRIIH FC ERRT 2

LGN HNLK FB 4%, WAZUA IR FC A I < RNt 28O ) AR &

FHIER)
ik = TEAR -3l HMAE
0.0 IN Open BOOL FALSE
0.1 IN Close BOOL FALSE
2.0 ouT Dsp_Open BOOL FALSE
2.1 ouTt Dsp_Closed BOOL FALSE
4.0 IN_OUT Valve BOOL FALSE

7 FC I AZ AL A L iR S i E AN A A/ AR A D g A U

FC MR . L HERR 55 A1 KA it 2 18] (7 I B 22 0 2 Je ) ] T A X S8 A i
A2 FC

HI T P (R Reas A0 T T B A i, I AT (K FC DI RELAIAE OB Z i1

1 STL il 5 (1 FCT R/ ¥ W R

Network 1 $TF/XKFFA$iTE
Al
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O  #0Open

O  #Valve

)

AN  #Close

= #Valve
Netword 2 £ “H&ITFTFH”

A #Valve

= #Dsp_Open
Network 3 B7x “H@IkH”

AN  #Valve

= #Dsp_Closed

Ab.25

X B OB1

OB1 YsE mBIREFPIEit . OB rh U & SALIR e KA TIRERI S5, Bl
o JHEREREE R LI G K STURE > BE R O LB A 5 (“ Start”) L4 11(“ Stop ™) »
Wi [ ( “Respense” )L S 4EY i7s( “Reset_Maint” )IAA S 4. PLCIAE

DGR A 18 22 b BHIX AN FE B FB

o IR HHLKIFBH AL, W% ATimer_NoflRespense_Timet 7~ AT # T i & I 4% Th g LL

S BRI A] o
o K IITHFCRIEHLIIFBAEEOBT I, T LLEAIER MR PR e ] G A
Pl A AL B

FEFF o AE PRGNSR FE AL AR 55, 0 AL FB IR Sl S 26 17 AN TR PR 55

71 0B1 FEE

OB1 HA & A IR R Jior. B 20 715 OB1 MABIEE, MREWHRIEL.

DB.

ik TEFE TEHA E i
0.0 TEMP OB1_EV_CLASS BYTE
1.0 TEMP OB1_SCAN1 BYTE
2.0 TEMP OB1_PRIORITY BYTE
3.0 TEMP OB1_OB_NUMBER BYTE
4.0 TEMP OB1_RESERVED_1 BYTE
5.0 TEMP OB1_RESERVED_2 BYTE
6.0 TEMP OB1_PREV_CYCLE INT
8.0 TEMP OB1_MIN_CYCLE INT
10.0 TEMP OB1_MAX_CYCLE INT
12.0 TEMP OB1_DATE_TIME DATE_AND_TIME
20.0 TEMP Enable_motor BOOL
20.1 TEMP Enable_valve BOOL
20.2 TEMP Start_fulfilled BOOL

A-69



B

ik TEFE TEHA E i

20.3 TEMP Stop_fulfilled BOOL
20.4 TEMP Inlet_valve_A_open BOOL
20.5 TEMP Inlet_valve_A_closed BOOL
20.6 TEMP Feed_valve_A_open BOOL
20.7 TEMP Feed_valve_A_closed BOOL
21.0 TEMP Inlet_valve_B_open BOOL
211 TEMP Inlet_valve_B_closed BOOL
212 TEMP Feed_valve_B_open BOOL
21.3 TEMP Feed_valve_B_closed BOOL
214 TEMP Open_drain BOOL
215 TEMP Close_drain BOOL
21.6 TEMP Valve_closed_fulfilled BOOL

45X OB1 125
1E STEP 7 v, AFANBE A H B SHE T A e MR Z BT A . fERBIFER T, AJIAE dnfE
OB1 Z Wi E B ALK FB AT FCo FB1 A1 FC1 7E OB1 AR I — i H; FB1
WV AR T AR 975 5% DB:

Z W F AR
OB 1
* | Feed pump . FB 1
ingredient A
[Instance DB 1
Inlet valve A T e
Feed valve A » o
Feed pump >
5 ingredient B f FB1
2 ) Instance DB 2
@ - S
o
% Inlet valve B FC1
i)
j=%
© »
Feedvalve B | | FC1
Agitator motor FB1
) ‘ Instance DB 3
»
Drain valve FC 1
Switch for tank level
b measurement
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STL 4WFE = 1) OBI FLFEHB 4l N s
Network1 ##ZR A BIE$i

A
A
AN

“EMEP_STOP_off”

“Tank_below_max”

“Driain”
#Enable_Motor

Network2 AECH A JFREHLH FB

“Feed_pump_A_start”
#Enable_Motor
#Start_Fulfilled

“Feed_Pump_A_stop”
#Enable_Motor

#Stop_Fulfilled

CALL “Motor_block”, “DB_feed_pump_A”

Start :=Start_Fulfilled
Stop :=Stop_Fulfilled

Response = “Flow_A”
Reset_Maint = “Reset_maint”
Timer_No =112

Reponse_Time :=Sb5T#7S

Fault := “Feed_pump_A_fault”
Start_Dsp = “Feed_pump_A_on”
Stop_Dsp = “Feed_pump_A_off”
Maint := “Feed_pump_A_maint”
Motor := “Feed_pump_A”

Network 3 @iRECHI A BYMRIERE

A
L
SD
AN
R
A

“Feed_pump_A”
S5T#1S
T 13
“Feed_pump_A”
T 13
T 13
#Enable_Valve

Network 4 Ec#} A BIN H A4z

AN
AN

“Flow_A”
“Feed_pump_A”
#Close_Valve_Fulfilled

CALL “Valve_baock”

Open :=#Enable_Valve
Close :=#Close_Valve_Fulfilled
Dsp_Open :=#Inlet_Valve_A_Open
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Dsp_Closed :=#Inlet_Valve_A_Closed

Valve = “Inet_Valve_A”
Network 5 Eok} A Byt #d iR
AN “Flow_A”

AN  “Feed_pump_A”
= #Close_Valve_Fulfilled
CALL “Valve_block”
Open :=#Enable_Valeve
Close :=#Close_Valve_Fulfilled
Dsp_Open :=#Feed_Valve_A_Open
Dsp_Closed:=#Feed_Valve_A_Closed
Valve := “Feed_Valve A”
Network 6 #H#l3R B ) E $i
A “EMER_STOP_off”
A “Tank_below_max”
AN  “Drain”
= “Enable_Motor”
Network 7 A EC#! B A 1A FB

A “Feed_pump_B_start”
A #Enable_Motor

= #Start_Fulfilled

Al

@] “Feed_pump_B_stop”
ON #Enable_Motor”

= #Stop_Fulfilled

CALL “Motor_block” , “DB_feed_pump_B”
Star =#Start_Fulfilled
Stop :=#Stop_Fullfilled
Response := “Flow_B”
Reset_Maint = “Reset_maint”
Timer_No :T14
Reponse_Time :=Sb5T#7S
Fault := “Feed_pump_B_fault”
Start_Dsp := “Feed_pump_B_on”
Stop_Dsp = “Feed_pump_B_off”
Maint := “Feed_pump_B_mait”
Motor := “Feed_pump_B”

Network 8 IEiRECH| B BYMR{ERE

A “Feed_pump_B”

L  S5T#1S

SD T 15

AN  “Feed_pump_B”
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R T 15
AT 15
=  #Enable_Valve
Network 9 el B B9 N O f@IEHI
AN  “Flow_B”
AN  “Feed_pump_B”
= #Close_Valve_Fulfilled
CALL “Valve-block”
Open :=#Enable_Valve
Close :=#Close_Valve_Fulfilled
Dsp_Open :=#lnlet_Valve_B_Open
Dsp_Closed:=#lnlet_Valve_B_Closed
Valve := “Inlet_Valve_B”
Network 10 EC#l B B9t # iR1E Hl
AN  “Flow_B”
AN  “Feed_pump_B”
=  #Close_Valve_Fulfilled
CALL “Valve_block”
Open :=#Enable_Valve
Close :=#Close_Valve_Fulfilled
Dsp_Open :=#Feed_Valve_B_Open
Dsp_Closed:=#Feed_Valve_B_Closed
Valve := “Feed_Valve_B”
Network 11 ##28 H B $i
A “EMER_STOP_off”
A “Tabj_above_min”
AN  “Drain”
=  #Enable_Motor
Network 12 /#2578 FH 1Y FB
A “Agitator_Start”
A #Enable_Motor
= #Start_Fulfilled
Al
@] “Agitator_stop”
ON #Engable_Motor
)
=  #Stop_Fulfilled
CALL “Motor_block” , “DB_Agitator”
Start =#Start_Fulfilled
Stop :=#Stop_Fullfilled
Response := “Agitator_running”
Reset_Maint = “Reset_maint”
Timer_No :=T16
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Reponse_Time :=SH5T#10S
Fault := “Agitator fault”
Start_Dsp := “Agitatoron”
Stop_Dsp = “Agitator_off”
Maint := “Agitator_maint”
Motor := “Agitator”
Network 13 HE$4 i 89 B $i
A “EMER_STOP_off”
A “Tank_not_empty”
AN  “Agitator”
= “Enable_Valve”
Network 14 HeiREH
A “Drain_open”
A #Enable_Valve
= #0Open_Drain
Al
0 “Drain_closed”
ON #Enable_Valve
)
= #Close_Drain
CALL “Valve_baock”
Open :=#0pen_Drain
Close :=#Close_Drain
Dsp_Open := “Drain_open_disp”
Dsp_Closed := “Drain_closed_disp”
Valve := “Drain”
Network 15Tank level display S#&E Z 7=
AN  “Tank_below_max”
= “Tank_max disp”
AN  “Tank_above_min”
= “Tank_min_disp”
AN  “Tank_not-empty”
= “Tank_empty_disp”

A5.3 AL H B A st

“HI R B R S5
FC 12

OB 10

OB1 1 OB80
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A5.3.1  “HEHET” BYHPREFREH

%
il Q4.0 A — B 5 00 RJH AT 8: 00 AL, MR 8: 00 2
— L B 00 AT,
Bin AR PEF
TRITR AR TFAT%
B HMES
0B1 PHINREFC12
FC12 Mk QA OPIRZS . I b e T (KPR A B N 100101 1T 5
o fREALUHI R
o BEE HIN Bl
o I H Ik
e CAN_TINT
0B10 P 1R B2 0T
o fRERLHI
o EIEEArHIHIQ4.0
o WE N AHNBR
o WIE NN
0B80 BT Q4.1
FEAT A7 Ak X IR A A7 OBSO HIAE Bl B
{5 A A btk
TR R G RIS R AN B R B X P AR
Hodk ax
10.0 HAE “ VR H I BRI F0 PO H I e A
10.1 O AN H It 7 (s A
Q4.0 i H IS B rOB (OB10) B A/ AT it
Q4.1 N )5 (OB80) & 1%
MW16 H Bl W (R &  (SFC31"QRY_TINT™)

MB100£MB107 OB10( 5 H i i s -5 B A7 X
MB110Z=MB129 OBBO(I [ 152) 1) 4 sh A5 B A7k X

MW200 SFC 28" SET_TINT"fRET_VAL (R [F11&)
MB202 SFCI b4 R CIREAIBR) ZAFIX
MW204 SFC 30"ACT_TINT"fJRET_VAL
MW208 SFC 31"QRY_TINT"HJRET_VAL
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& ARy R ThREFN TN BE
FEGmRE R B P AT T BUR RS fiE:

A.5.3.2

EIRAERS

e SFC28 “SET_TINT”
e SFC29 “CAN_TINT” :
e SFC30 “ACT_TINT”
e SFC31 “QRY_TINT” :
e SFCT “D_TOD_DT”

FC12

: BB H It

IR I ke

WO TN b

A b i

: 5 DATEFTIME_OF_DAYADT.

LAR AR FC12 (7 873 75 W AR I e 33 o«

Variable Name DateType Declaration Comment
IN_TIME TIME_OF_DAY TEMP LEbmling ]
IN_DATE DATE TEMP B H
OUT_TIME_DATE DATE_AND_TIME TEMP B 5 IR Bl H 1/ )
OK_MEMORY BOOL TEMP {F8E H I 2h e Wi B
STL #F&5
0 STLZw S I P R FC12 R
STL(FC12) fRRE
Network 1 SFC QRY_TINT
CALL SFC 31 A I T RS
OB_NO =10

RET_VAL:= MW 208

STATUS := MW 16

Network 2
AN Q 4.0
JC mond
L D#1995-1-27
T #IN_DATE
L TOD#20:0:0.0
T #IN_TIME
JU CNVRT
mond:L  D#1995-1-23
T #IN_DATE

EAH H IR 2 T

G H 2 21—
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L TOD#5:0:0.0
T  #IN_TIME
cnvrt:NOP 0
Network 3:
CALL FC 3
INT = #IN_DATE
In2 = #IN_TIME
RET_VAL:= #OUT_TIME_DATE
Network 4:
A 10.0
AN M 172
A M174
= #OK_MEMROY
Network 5:
A #OK_MEMORY
JNB m0O01
CALL SFC 28
OB_NO :=10
SDT = #OUT_TIME_DATE
PERIOD :=W#16#1201
RET_VAL := MW 200
m001T A BR
= M202.3
Network 6:
A  #OK_MEMMORY
JNB mO002
CALL SFC 30
OB_N:=10
RET_VAL := MW 204
m002 A BR
= M2024
Network 7:
A 1041
JNB  MO003
Call  SFC29
OB_NO:=10
RET_VAL:=MW210
m003: A BR
= M2025

M DATE 1 TIME_OF_DAY #4524
DATE_AND_TIME(H - # & H I #h o
)

BEE I B e 7 10 SR A7 4 i AL 2
CfERERM AN EAL S H b e W7 R B0 LA
JH Bl OB LS4 i,

B H N e

=+« JF LS F IS Bl e

L SRIBGH H N Bl W fa AN EAL T, )
TR 1 et b
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A533 0OB10

A ARER S

5 OB10 (4 F B3 R, LA R I A JRy il e B33t 47 7 1
o T AT B RIS M AR(STARTINFO)

o {ESTARTINFOZ K& N I TN 8] O 45 44 {A(T_STMP)

o HTIEI FIRAR BWDAY, IN_DATE. IN_TIMEFOUT_TIME_DATE

TEHZ b il TEFR | K
STARTINFO STRUCT TEMP OB1OM#EAN I B =115 B A5 W
g AT

E_ID WORD TEMP FAED
PR_CLASS BYTE TEMP etk
OB_NO BYTE TEMP OBl
RESERVED_1 BYTE TEMP 84
RESERVED_2 BYTE TEMP {5
PERIOD WORD TEMP FI 4 e B 1 ) 4
RESERVED_3 DWORD TEMP e
T_STMP STRUCT TEMP FHT E 4o B 40 25090 £ 46 40 4
YEAR BYTE TEMP
MONTH BYTE TEMP
DAY BYTE TEMP
HOUR BYTE TEMP
MINUTES BYTE TEMP
SECONDS BYTE TEMP
MSEC_WDAY WORD TEMP

END_STRUCT TEMP

END_STRUCT TEMP
WDAY INT TEMP A
IN_DATE DATE TEMP FCIMim AR &

CH %A% 20O
IN_TIME TIME_OF_DAY TEMP FCIMim AL &
CIf T A Afp 20O
OUT_TIME_DATE DATE_AND_TIME | TEMP FC3 1% A% & ANSFC28 14 AN AR
=N
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STL i2FE %
i H STL 4w 5~ #2)7 OB10 'R :

STL(OB10)

s

Network 1

L  #STARTINFO.7_STMPMSEC_WDAY

L W#16#F

AW

T  #WDAY
Network 2:

L #WDAY

L 2

<>

JC mond
Network 3:

L  D#1995-1-27

T  #IN_DATE

L TOD#20:0:0.0

T  #IN_TIME

SET

= Q40

JU  cnvrt
mond: L D#1995-1-23

T  #IN_DATE

L TOD#5:0:0.0

T  #IN_TIME

CLR

= Q40

cnvrt: NOP 0
Network 4:
CALL FC3
IN1 = #IN_DATE
IN2 = #IN_TIME
RET_VAL := #OUT_TIME_DATE
Network 5:
CALL SFC28
OB_NO :=10
SDT = #OUT_TIME_DATE
PERIOD :=W#16#1201
RET_VAL := MW 200
BR
= M 2021
Network 6:
CALL SFC30
OB_NO :=10
RET_VAL := MW 204

R

WA A —, W45 52 Al —,5.00AM 25 F—A4~
A BN H A 5 H Q4.0

T, n S —, ¥8E A 1, 8.00pm (20.00)
1R R — AN B i ) AL 4 Q4.0

JEBIR RE (I ]
HeAd 2 RUESUG I 7] 4 DATE_AND_TIME#%
(T SFC28)

PR ol
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A BR

= M 202.2
Network 7:

CALL SFC20 Peflead ¥ OB 10O AR BN A5 B o 1 [

SRCBLK := #STARTINFO.T_STMP 14k B A X BIMB100E MB107

RET_VAL := MW 206

DSTBLK := P#M 100.0 BYTE 8

A5.34 0OB1 %1 OB80
HITAEAS] b B VRl OB (M THEM L F19 OB)IEE S FfF(5 L, prLliEzr OB8O
B HIEE.

OB1 EF&ER %
{1/ STL4'S KA P REFF OB1 W F:

STL(OB1) fif ke

CALL FC12 PHH DIREFC12

OBS80 A RAERSY
L5 OB8O 48 75 I A AT, LA I JRy A et B AT 75 1«
o JHT AR FAE RS K (STARTINFO)
o {ESTARTINFOZE 4 1A Py 1) FH T I T 5 K 44(T_STMP)

TEZ ke i) TEER pEs

STARTINFO STRUCT TEMP OB8O AL B FHF5 B
VIR LTS

E_ID WORD TEMP HIHD

PR_CLASS BYTE TEMP 52

OB_NO BYTE TEMP OB5 1Y

RESERVED_1 BYTE TEMP {74

RESERVED_2 BYTE TEMP ke

A1_INFO WORD TEMP IR 3 B 5 ) A ) B A
B

A2_INFO DWORD TEMP KT AR HOB 515
(B A 6

T_STMP STRUCT TEMP FHF H B4 0 40 258 1) 465 R A

YEAR BYTE TEMP

MONTH BYTE TEMP

DAY BYTE TEMP

HOUR BYTE TEMP

MINUTES BYTE TEMP
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TEZ HiEAE LEFH ER
SECONDS BYTE TEMP
MSEC_WDAY WORD TEMP
END_STRUCT TEMP
END_STRUCT TEMP
OB80 2 F#R 4>

{1 STL 9’5 f A #2/¥ OB10 I

W I (Al R, BRE RS S OB8O:

STL(OB80) fERE
Network 1 Gn R AR L, B2 Q40
AN Q41
S Q41
CALL SFC 20 Heftik: AR FIHE BRI X EMB110
SRCBLK := #STARTINFO £MB129

RET_VAL := MW 210

DSTBLK

:= P#M 110.0 BYTE 20

A5.4  A-IBET(E)HEIR & #T B 7RI

A.5.4.1

%

IR IR P P R
0B20. OB1

“HYEER T PR RILEA

M 10.0 FAL, Hith Q4.0 NAE 10 B R EAL. BRI 10.0 EAL, FEIRIN (8] #KRE B

Jazl.

IS 1) S2E 3R P T R 0 I T (R0 AN 22 ) WA O P 2 SCHKD 1D BILAE IR T] 2258 7 B OB(OB20)

Frsh S E R .

WAL 10 FB4h P 101 #E A7, WAL OB20 ARige i XMt Q4.0 ARk

B

M 10.2 EALN, Fid Q4.0 N E AL,
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i AR PEF
TRAEANRTFATS
653 SES
0B1 T2 RN 1) 5 A 3 ) ) i 5R B A T
FR A5 N0, O IA IR AR 4K, AL IS 8] GE IR A 75 AR 48 T 1) 4B 38 7 ) bR 2 A
FANION WAVt , B GEIR Hr s EE4RANI0. 2100 RES, A
111Q4.0
0B20 B Q4.0
B HHER 2 R[]
o B A BAT B AF G X 45k
{5 F B btk
TR AR S R, I R A A ER R B X A
ik aX
10.0 {fifie “AB I AEIR W I
10.1 IR AN IR ) 238 H () N
10.2 ALK Q4.0 A
Q4.0 FH I 1) 4235 P T OB(OB20) B Iri i A
MB1 FAEILIEARE B SFCI I 45 R CIRAEMBR) 2247
MW4 IR SE IR R IR RR A (SFC34"QRY_TINT ™)
MD10 K F OB ) 115 B I FZ R BCDRY
MW100 SFC32"SRT_DINT"RET_VAL GRIFI{E)
MW102 SFC34"QRY_DINT"HJRET_VAL
MW104 SFC33”CAN_DINT"fJRET_VAL
MW106 SFC20"BLKMOV" [HRET_VAL
MB120-MB139 | OB20&shFif5 B IIAF-ikIX
MD140 K H OB20M AT s F -5 B P M= F2 1 BCDRY
MW144 K H OB WS sh 5 B FIZ R (BCDRY; B H OB20MI& 8 ZH 115
B CH P REIDSIGN)

ERRI AR HE
PIR AR “IFIRIGEIR ™ (0 R e v S G SFCe
o SFC32 “SRT_DINT” : Jiishiid [l i3k rh
o SFC33 “CAN_DINT” : I I i) 48 7
o SFC34 “QRY_DINT” - i il 4 38 v 7 (R bR A
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Ab4.2 0B20

A ARER S
5 OB20 &4 A B AN, TF A1 i R AL s B AT 75 PR
o JHTHEARBFIE BB L AE(STARTINFO)
o TESTARTINFOZiHa 44 A - i) 1 45 44 fA(T_STMP)
TEHZ b il T =R b
STARTINFO STRUCT TEMP OB20MHE 5 {5 &
E_ID WORD TEMP YD
PC_NO BYTE TEMP e
OB_NO BYTE TEMP OB 14
D_ID1 BYTE TEMP HARIDT
D_ID2 BYTE TEMP H41D2
SIGN WORD TEMP H PR E D
DTIME TIME TEMP IS ) S2E 3 o 1Ry () T
T_STMP STRUCT TEMP FH T IR 40 25080 11 6 40 4
CITRTER LD
YEAR BYTE TEMP
MONTH BYTE TEMP
DAY BYTE TEMP
HOUR BYTE TEMP
MINUTES BYTE TEMP
SECONDS BYTE TEMP
MSEC_WDAY WORD TEMP
END_STRUCT TEMP
END_STRUCT TEMP
EFERS
{1 STL 4w 5 A P #2/% OB20 41T
STL(OB20) TR
Network 1
SET T E AL Q4.0
= Q40
Network 2:
L Qw4 IS B
T PQW4
Network 3:
L #STARTINFO.T_STMPSECONDS MRS FARAE B
T MW 140
L #STARTINFO.T_STMPMSEC_WDAY AL Z) F A5 B A B RO R 1
T MW 142
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L ™MD 140
SRD 4
T MD 140

Network 4:
L #STARTINFO.SIGN
T MW 144

Network 5:
CALL SFC 20
SRCBLK := STARTINFO
RET_VAL := MW 106

L ANPPRZREH S (BHEMWI427F
BCDfiH)

MG A5 S5 A 32 6 1] S 3R A I8 AR A2 20 i ]
(=1HISFC32)

Rl sh gt R R 64 8 (MB120%
MB139)

DSTBLK := P#M 120.0 Byte 20
A.5.43 OB1
EIRAERS

55 OB1 i Fa W HEIp AN, LT e I Jy AR Bt AT 75 1]«
o T HEARIGE RS A(STARTINFO)
o {ESTARTINFOZE# 1A T I [ IR 254 14(T_STMP)

TEZ B LR TEFE AR a3
STARTINFO STRUCT TEMP OB sh {7 &
E_ID WORD TEMP F{EID
PC_NO BYTE TEMP etk
OB_NO BYTE TEMP OB
D_ID1 BYTE TEMP HARID
D_ID2 BYTE TEMP H4EID2
CUR_CYC INT TEMP A HTAEER I ]
MIN_CYC INT TEMP B/ NGERI ]
MAX_CYC INT TEMP B ARAGERIN 7]
T_STMP STRUCT TEMP T H et gn s (o s ik ot
EI{ZIETE)

YEAR BYTE TEMP
MONTH BYTE TEMP
DAY BYTE TEMP
HOUR BYTE TEMP
MINUTES BYTE TEMP
SECONDS BYTE TEMP
MSEC_WDAY WORD TEMP

END_STRUCT | TEMP

END_STRUCT | TEMP
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BFHS
{1/ STL %5 B H 7 #2)/7 OB10 Ui -
STL(OB1) i
Network 1:
L  #STARTINFO.T_STMPSECONDS MR B A L R
T MWI10
L #STARTINFO.T_STMPMSEC_WDAY R By A S P s R A A
T MwWI12 ZERUE WIS 22K (Y BCDASAEMW2
L MD10 H
SRD 4
T MDI10
Network 2: HINI0.0Z A ETHE?
A 10.0
FP M 1.0
= M1
Network 3:
A M1 WIRAT, SIS A ZE IR iy
JNB  m0O01 (IS TR ZE AR 0 BT RS 2 I TRI IR 25 24 SIGND
CALL SFC32
OB_NO :=20

DTME :=T#10S

SIGN =MW 12

RET_VAL :=MW 100
mO001: NOP 0

Network 4:
CALL SFC 34
OB_NO :=20
RET_VAL := MW 102
STATUS =MW 4
Network 5:
A 101
FP M 13
= M14

Network 6:
A M14
A M52
JNB  m002
CALL SFC13
OB_NO :=20
RET_VAL :=104
mO002: NOP 0
A 102
R Q4.0

LTI (i) G 38 P T (R IR S
(SFC QRY_DINT)

WAI0047 ETHHE?

o3 ELIAES T L i)
(LIRS IR A :2) 2
R T

FHANI0.28 (i Q4.0
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Ab5.44 RS ETRE#E DS IR ARG
uTFHFLEF%‘E/JTW 1ot I 44T 5t R R PR KT Bt i R 25 4 . i SFC36 “MSK_FLT”, BLF
T CALE S FR £ 12 0 356 4 HP 4t 7 i«
. 1’Fi§%§%{’FHﬁE’~JBi§ZK}#%§f
o (EEHERAEN I XK B R
P SFC36 “MSK_FLT” i a] LAGE e — AN ) X 35
o VEBHEAERI/OVT ) £ %
{fiH SFC38 “READ-ERR” W] ifi# it i 1 IFl D4k %« H SFC37 “DMSK-FLT” “’H#:4E
I /O Ui IRl &5 R 1) Bf ] AR HGE -
e
LE R OB ] LUE Bl FHE A R g (1 H P R = i) o
STL(Network 1) fRR%
AN M 255.0 AR EEAEAH A M265.0( L 5 88— ki 4TI =0)
JNB  mo001 SFC 36 MSK_FLT (5t ik [A 548 %)
CALL SFC36 f72=173="1(BLFLFIBLFS#: 5t k)
PRGFLT_SET_MASK :=DW#16#C FITE L =0T V7 o) 4 5 45k 5 i)
ACCFLT_SET_MASK :=DW#16#0 IR [AME
RET_VAL =MW 100 A 2T G A R T 28 FIMD 10

PRGFLT_MASKED :=MD 10

ACCFLT_MASKED :=MD14

s AT R AT IR T A FIMD14

L B i R B A2 M255.0

m001: A BR
S M 255.0
STL(Network 2) fRFR
CALL SFC 36 SFC 36 MSK_FLT(5# il [q] 245 1%)
PRGFLT_SET_MASK :=DW#16#0 BT N =08 A S 325 1 g R 4 B i)
ACCFLT_SET_MASK :=DW#16#8 Pr3="1(EHEAE V7 M H R85 5 k)
IR
RET_VAL =MW 102
PRGFLT_MASKED :=MD 20 i 2 T R RS R TR A8 2IMD20
ACCFLT_MASKED :=MD 24 i 2 W g RS R TR S BIMD24
STL(Network 3) i
AN M 273 WIS 1 il 45 17 (ACCFLT_MASKEDH [ {7 3) %
BEC A BN e 2 o
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STL(Network 4) fRFR

L B#16#0

T PQB 16 M PQB161E 5 V7 il (FH #U{E0)
STL(Network 5) fRTR

CALL SFC38 SFC 38 READ_ERR(£ ] [H] 245 %)

PRGFLT_QUERY :=DW#16#0

ACCFLT_QUERY :=DW#16#8

BT A AL =0(BE A gt i 1 4 A0 A1)
FE3="1(E W55 ) %)

iRl {H

RET_VAL =MW 104 i H T G R IR T S UMD 30
PRGFLT_CLR  :=MD 30
ACCFLT_CLR =MD 34 i 2 AT g REAR R IRTE 85 BIMD 34
A BR Tea s LT HAEAS 25 7 ) iR
A M373 RLOHU %
NOT U EPQB 1677 £4EMIMO.0=1
= MO0.0
STL(Network 6) fETE
L B#16#0 M PQB174E S i In] (H £ {H0)
T PQB17

STL(Network 7)

R

CALL SFC38
PRGFLT_QUERY :=DW#16#0
ACCFLT_QUERY :=DW#16#8

RET_VAL =MW 104
PRGFLT_CLR :=MD 30

ACCFLT_CLR =MD 34

A BR

A M373
NOT

= MO.0

SFC 38 READ_ERR(#x [l P 4 1%)
BT A AL =0(BE A G B 1 4 A0 i)
FE3="1(E W55 ) %)

R [EHE

a2 AT PR AT DR IR E AR 2IMD 30
s AT AR AT IR IR A 2IMD 34
TR BT e & S5 7 A iR
RLOMY J

WIHRPQB17/7-ENIMO.1=1

STL(Network 8)

R

L  B#16#0
T PQB18

1l PQB181E S iy ] (FH A {1 0)
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STL(Network 9)

e

CALL SFC38

PRGFLT_QUERY :=DW#16#0

ACCFLT_QUERY :=DW#16#8

RET_VAL =MW 104
PRGFLT_CLR :=MD 30

ACCFLT_CLR =MD 34

A BR

A M373
NOT

= MO0.2

SFC 38 READ_ERR(#x i [F] D44 %)
P B =0 (KA S e A e i & 1)
RE3=1(E WS Vi)

IR [H{E

T TSR A DRI E AR 2IMD 30
v AT AR AT IR IR A 2IMD 34
TR BT e & S U5 7 AR
RLQH %

WIRPQB18474: MIMO0.2=1

STL(Network 10)

TR

L  B#16#0
T PQB19

5] PQB 191 5 17 1 (F £{#.0)

STL(Network 11)

TR

CALL SFC38

PRGFLT_QUERY :=DW#16#0

ACCFLT_QUERY :=DW#16#8

RET_VAL =MW 104
PRGFLT_CLR :=MD 30
ACCFLT_CLR =MD 34

A BR

A M373

NOT

= MO3

SFC 38 READ_ERR(# #i[F] P H11%)
P AL =0 (5 A S e AT e 2 )
Fr3="1(E WS 5 %)

iRl

a2 AT g AR AT IR I E 25 2IMD 30
i tE U AT AT IR T 25 FIMD 34
o R T BAEK A 5 U ) 4 %
RLQHLX

W RPQB19A7AENIMO.3=1
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STL(Network 12)

R

CALL SFC37

PRGFLT_QUERY :=DW#16#0

ACCFLT_QUERY :=DW#16#8

RET_VAL =MW 102
PRGFLT_CLR :=MD 20
ACCFLT_CLR =MD 24

SFC 37 READ_ERR(H ¥ it il [F) AP 4 122
T AL =05 A 1E— 2 R FE RS R BEDT 0
RE3=1(5% i S Vi W B )

iR [l

B A ET g A IR 22 FIMD 20
i T g A T 2 BIMD 24

STL(Network 13)

i

A M273 0 5 5 [l 4R (ACCFLT_MASKEDAZ3) A 4
BEC T o g ) e TR
STL(Network 14) Rz

A MO0.0

JNB  m002

L IBO

T PQB 16
m002: NOP 0

WSS, 1£i%IBOFIPQB16

STL(Network 15)

TR

A MO0J1

JNB  mO003

L IB1

T PQB 17
m003: NOP 0

WIRAFAE, 1£1£1B13IPQB17

STL(Network 16)

s

A MO0.2

JNB  m004

L B2

T PQB 18
m004: NOP 0

WA, 1£i%IB23IPQB18

STL(Network 17)

A MO3

JNB  mO005

L B3

T PQB 19
mO005: NOP 0

WA, 1£i%IB3EIPQB19
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A5.45 EFF{FEREF TR F T iEIRAYRBI(SFC39 F1 SFC40)

FERXA PRSP IR B RE 8 2 AN RER W I XA Ry ] SFC39
“DIS_IRT” %% 1E OBIB(fEHA NI ], LLERT LA SFCA0 “EN-IRT” FH B fig

SFC39 il SFC40 7 OB1 il i

STL(OB1) R
A MO0 AT LA T R
S M 90.1
A M 0.1
S M 90.0
CALL SFC39 BN TR T 2850+

MODE :=B#16#2 5 |- R
R 100 B2 A OB
N 4110835
L PIW 100
T MW 200
L MW 90
T MWwW92
CALL SFC40
26
MODE :=B#26#2 Wl
OB_NO =35 Bist2: AR/ OB
RET_VAL :=MW 102 {fifizOB35
A M 10.0
S M1901 LA TR R # 53
A M 10.1
S M 190.0

Ab5.4.6  HETFISFEIEIRAEIRALIERAI(SFCA1 70 SFCA2)

FEAGII P RE P, ABCE S8 0 R P AN RE R W P o DI B> RE S A SFCA1

“DIS_AIRT” ffirpIbrsEiR, Ll H SFC42 “EN_AIRT” ffifig.

SFC41 #1 SFC42 7E OB1 i H:
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STL(OB1) i
A MO0.0 RJ DABE BT AR 7
S M 90.1
A M 0.1
S M 90.0
CALL SFC41 TR A T O B4«
RET_VAL =MW 100 4 |1 FGE R G
L PIW 100
T MW 200
L MW 90
T MW 92
CALL SFC42
T BT L (0 R IR [P T
ZEEAE P T RR 5 B b WA T AR R
oEe i GXHA “0™
L MW 102 A
<>
JC err
A M 10.0
S M 190.1
A M 10.1 - " S
S M1900 AT LA T (R R 4
BEU
err: L MW 102 B

A.6 i) IR IR XA SN EHE X

A6.1  ipiEEIREEX

CPU B AT LA o {7 FH 3o o ke A5 38 1] 42 D7 1w e o A X80 A b AR ) B A\ R

i, WAL TP S E AT 1] .
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CPU Sl L T 4R/P e 2 B4 i) b SRy A a0 E AN 20 sCBEAOU I N/ B . A mT LU A5
PRI BO I R WG X L

&R
AN R, AR STEP 7 ZLABHEUN R TP R e v A H ) ik 23 FC 5 BEAR -
o XFTHRIVOBIN: AR A EHLAIFRR 2) BE 225l

o T HEAIRI/OPROFIBUS-DP) 3k fEZHAZRM “master system(fE R 4k)” 4z
HEDP M, % B PROFIBUSHIHE FfB AR 43 ic 31 - A

TR A, AT I RAERE MR B E L. A4S REUR, it as it Eud
JikF) CPU 13 CPU e I 7 B 4h & IR
SMg 1/0 Fk

S N A R L (R, KRR S X BT ML R AL B AR U 74, 7,
15 FLIE B4 A AR VR | R OB Q.

s Al A Btk X

Mok (X ik Bl TT S7HRIAFF (IEC)
S (/0 KHKk: WA AR T PIB

SR BN PIW

AN AT PID
SR (110D K I: it S B PQB

S Bt PQW

A1 B HH AT PQD

PR HRAE AN L mT DU W et bk DX ds, T 225 DUR
o “S7-3007 guFifaililay, MELERNLE” T
o “S7-300, M7-300W] guffEiilat, BB E A S TN
o “S7-400, M7-400v]gufEyEhilas, BUAREAMIES % F M
IR A iRttt
AT G i bl 2 AR (4 S AR T 1T b o e AR FRAZ AR 1) ) P 258l X S g ad ik, /Y
Z1E LT SRR R o
B, R, W A H SR I DL R PR e e I e A R R 2
UG 5 B 5 B i AN B A ah ik, DRS00 5 2 v T PR A

A6.2 SUtIMERIERX

A X 50 9 LU JLEE 2
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R &R

o M HELLL
o ZWTRIZHEI
A DA A i A\ DX R A DX (U)o

FH P BCE T LUORD 75 ik O] 80705 5 BR0BR) B 7 b i (o B el R AR ) >R - ik i N i 1
k. P Ee T DU B ML 2 a4 . T3 D RE (64 B2 3% V5 )k 1), Bl it 4%
LIS FRARIX . P B AT DU DA 4505

o SR EE SRR B E AR AN S S

o SRENREA I RIS B

o Sk EETVBRR B A 3 SRR I S EU(H A S7-300)

AEREFH BRI, R i AL 4 AT (DP ARMEMNIE AN, WA E BRI TERE) . SR
CALERT” 84, DUANESE HAR S S (— 300 T kit o n BARS AH POAS “ A1
WA H84, WREAE W OB B A 24l AE 54 2 1) LR A A8 1) W] — Mk AL 326 B 2 ),
XFE 4 AN T35 R I P B AE S A I A BB AL 3% 2 i Al e S i Zs

LIS LR

HEEIRIER

AR P12 W R 2 B8 AN BE 6 1 B - i (ELE PT DA L — S 58 B U e A0, IR B
A DB A — EHS WA 2 5

XS WA 2 B R U5 1) 7] DUAE TSR 1 2 4 s ik AN 54 12 5% 5 (DS) o Bt ic % m] 23 i
AN A HOC % o SR IC S RS, A B L sk RS . T LU R SE T BE B IR
HRECH P LDV I B ic sk N R  Bdia il sk 5 S Wi 2 5080l 2 I G &R

i i

ZWTEE WRAZBARAT ST RE ), ) R B A 10 S O T SRAHEAR 112 W il
SR AP AR AT A1 2, T B 1) B i SR ORI AR S B A T K 2 B AR 1A FIREAR

A LA PSSR F) 508 10 5k R4 S 4 T S AR BT (E 2 0, JF HLaT LLBSAT 2 Wi e I 1)
BRAR FIZ WA R

MR PR L R GE L fE AT LUK DT ) B il %

SFC | B#

HBIRMES

SFC55 WR_PARM LB NS (BERICR) BIFHLME S5 HAR

SFC56 WR_DPARM JSDB100FE 129%% 58 (FrdH0osk1) 2T hk 115 5 AR

SFC57 PARM_MOD MSDB100E 129114550 (H410581) 215k i4E 5 B

SFC58 WR_REC ALAEAT K 21 - Bk 945 5B
LS B
SFC59 RD_REC Bt
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Stk S5 1R

gy
b=

Wi —/~ DPV1 gt 4144 H GSD 3cff (GSD Rev.3), JfH. DP it DP #: 1%
B “S7 FRAMIRT, Rl SFCH8/59 5 SFB53/52 ARV 1) /0 Kb Sk 4
Ko JRRE UL DP Fsfrt fh bbb iR (SRS +3) .

fif 5% R DP Eub ik B E S| “DPV1”,

AT LA N R i vy ) S5 ARAR -
o IR IMABS-24 —ANS7-4005 SIMATIC S5 LA
o CKBEAEIE L& I SRR FR 7ES7-400 1) HR JLHLEE I

Wi #E SIMATIC S7 H 5-4ik S5 AR (KRR LE “S7-400, M7-400 A] e fEa il 28, RdfFFf1 22
67 T B E S R L

A7 BRI

AR FE W AR e T T 1 R G S B U R A DR (SFCME L S7-300 Fl S7-400 1] 4fE 4%
2% (0 BE Ry

A LAYE STEP 7 (748 By LLK R 51 -t h #6356 TR S 40 S ve a5 8

o “S7-300m gufEiEildy, MPEAILRE” T

e “S7-300, M7-300W] gufiEihilgs, BAREAME” =% F

e “S7-400, M7-400W]gufeEiilds . BARBARMIE” 5T

7E “S7-300 #l S7-400 R, RAEFMbrHELIRE” S5 T Ml LAREIST SFC 1T
H A2

F ik DP #RE MG
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WL DP BRIl 2 18] (s SO T 4 A1, e 2504 3l Al A2 4 ) e ok
1) SFC.

—EEHH CPU Hidid /O MBEXASHK T 4 AP REELL SR, AP ZHE A
SFC14/SFC15 (ZZXJ /34T 2\ /O LA 3 5 (WA ) .

SFC IEE

AR E S 5T

SFC 15 DPWR_DAT | AT T3 B B S0 1 A5 5 AR

B 2 e B

SFC 13 DPNRM_DG BsTE R R

SFC 14 DPRD_DAT BLELMEHE (KA EAT R FANFD
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A.7.1

REIRE

H—A> DP 2 Wi BliE I, —AMF 4 Nz kiEdE R CPU 2 W k. w7 LLEH SFC13
DPNRM_DG i X 4 745,

B AEAR R P REAN4F 1%

HE I AT ST TG R A 1) T SR AT IS L R N I kA B IR
SR, AT LAST RIS SRR T 0 T AR AL T B o I e a1 AR A LA T AR ASEAR
UEE

o “S7-300ngmFEyEthlat, MERIEE” T
o “S7-300. M7-3000] gmfeiathildy, BARBARMIE” 5T}
o “S7-400, M7-400T]gmfE=hlas, AAREAMIE” S5 F

WL 454 AT LA B S 307

AT LUE SRR O PE REARF I, e AT TG B 2 BT P SR AN T 5 0L T 4LaS Mo CPU.
FM. CP LK — LU o A/ HHAASOMI A 7 f i AR o

A AL SR 1A Ja o5 i, 3 AT i 6
BOA 5 & FLM AR E AT AT 1 P S R e AT B B (I B o XSRS B R A7 42 CPU
(R T ORFFAAA# DX Sl (el CPU A TRIE2 1 2 0 M) o

WEMRHSH

FUAH] STEP 7 BB S8 AR LE S5}, STEP 7 B8 “ Rtk ”, €
AP R —E T2 CPU, 4 CPU JA 3N Lk BIRR L.

RILUEMRLL i E?

WA S E o S H . fE “S7-300 ] gmfefsitles, MiEfd:” FMLL R “S7-400,
M7-400 A] g FE sl %, B E AR ML ” 22 T b ke T WL e fEmpes CPU %%
o

SRR

o JAZhTERE

o fEI

o MPI

o Ll

o RFEFEE
o INAIAEAH

o THTALE

A-95



B

o ZERI/O(HS7-300)
o TRIPEELL
o JRIBEE
o SZINFIE 4D

o PR

F SFC{ES (&

Bx T H] STEP 7 U AL, IErTLLH S7 B R G E it Z50. TR Ut
48 SFC AL IR LU S 4L

SFC

EL:)

SFC 55 WR_PARM

X PRI CBRILRT) BT U SRR

SFC 56 WR_DPAPM

MAHRN FISDBAIA S (Bt id 01D BT HERIME S 1Ak

SFC 57 PARM_MOD

MARREISDBALIE T AT 25 (Hiidk0m 1) 2 FhkIfE SRR

SFC 58 WR_REC

AT R HAR L B T HERIF 5 AR

£ “S7-300 F1 S7-400 AL AT, RHGMBRHELIRE” S5 F M A R T R DRERI A

PUR T e e 1 Wb LAt 2 Hon] LA sl 35 18 04
o “S7-300n g g, MR T
e “S7-300, M7-300nIgifeEdilds, BURBAMIE” 2% T
e “S7-400, M7-400n]giREfEihlas, BRBAMNL " ST

A72 BEREHERSTRERROBEMGRAE GRIERS

% R BD R A7 fit R A3 BT SO

LA B A

S N

PITIRIER RRIES

MTHTAR AL oK UPD SCPERE DL 3% H %

RS Hr4 PLC > Update Operating System
76 IR0 UG HE ke UPD SCEFI H 5%
HPEAEAT—A UPD SCAF

. i “OK”, B HXHEHE

A7 fitas RidA PLC Hio

1. Kf CPU [ HIYE(PS FitR)
2. KeUER I I A BRAE R GRS A il 4 R4l PLC T
3. CPU L. IWAFfifids R AE RGULIE S A H FLASH-EPROM , #4011, CPU
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ERPATIR AT Ri5E

4. RAWHEIG, BAERGEREHT . CPU LIt STOP Ha/m AT i 18 I k48 7 58 ) 58
JR(FR G RAT fik s R A7)

6. SREHI, AT ARG R

o A, CPUK AT S LA, 25 CPU BRI LUEAT T .

7. SR SRR AR B R

A73 (EREHIhREE

T S7-300/-400CPU #2847 — AN Bh (S o) B B B AR I ) o 3K A BN AT 7 ] G
FEiflge s, BDREAE 0B BEVE G B0 R I . H B Bpep WA CPU G2 4T 1 1]
A s T EIX AN B

A EA& =X

ISR SRR IS ) (B VRS B2 1 A8) . HHBIANER . A2 CPU IE v] DU 7R 2 (27 “S7-300
g TIES, MR FLA K “S7-400, M7-400 Rl g Fa s il ds B AR G 7
ZHTFM).

1B FAiZ AT 8]
A LR R A L ) SFCO SET_CLK #¢'% CPU IS [RURTH i 4, st A gm e as b
5 SRR TR S i e, ffF SFC1 READ_CLK BiZafess s sk miny LLsk CPU 41T
() H SIS 1)

H BT IRE S5
AR — AN A E— AR B I Bl 20 STEP 7 BB S 836 52 24 ) 7] [7] 25 15 1k
AN CPU ZOREANE, WEA AN . HVBEESEUN, 8Tk s i TR] A 0 o TR 2 45 R 2D i 2
Wit s, LUROE I A B 31 25 A6

[5] 45 B (8]

DA OR 90 208 T FRY BT AT RSEAR R IR TR i — A, AR D) ey R G0 P DA — A s S 0y (T 2k ) 1) B
e A, WAl LA R Ge 2 SFCA8 SFC_RTCB 4 A= I i) H AN [ 4 126 45 MBS el .

fEM—> CPU s&1ThY a1+ 8 =s 425
CPU 3247 IR 1) T K ot P 422 ) B 26 B4R A I 1) 0 CPU AR RIS AT I T JEAT T4

75 STOP MR, 6 /7IN IR B I 1k, 2 IV RO E A7 W 8 52 R F Ul (. 7EAE
WAL, CPU SE1T I [ v s A P T B 2 7E RN, L BT
CHEEN T, BLAEN AT FZ)IEAT .

A LAR SFC2 SET_RTM 4% CPU & A7 I ) vh #o 4% v & — DI ah . LA SFC 3
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A7.4

EfShiEfEes

A RERTSRER

TE R 25
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{5 FA R e 75 i 28 F0 E B 28

CTRL_RTM JAghlif 1l CPU S 4TI [l it 4y . WTLLH] SFC4 READ_RTM 15 i i 4%
/NI ORI AR IR (A5 1k 3“0 ).
/> CPU I Z W47 )\A> CPU I I [ o1 s . S A O JT 4o

oo
21]

I BRAE At 5 AT RELEALAPAE RIS 4TrR, R MRS 1 1 i B A I
A VRN 0o 24AEH] STEP 7 D4 IR BA7ff St 2 £onf, T LLESFAE CPU AT FIWEAM A7
filia 747

A AR TP R v A T I B i 70 00, R 3 — A I RAT Bl e — A J ST 4
(G, I AL FRE) .

I Eh AT RE AL T AR N RO R

A7 s 7 1 TR 7 6 5 4 8 2 1 0
JEi(s) 20 |16 10 (08 |05 |04 [02 |01
Wi (Hz) 05 |0625 |1 125 |2 25 |5 10
7N

BT S CPU RN, w2 l, £ MKIEINN, I aE 73RS
A RES A TR

SE IS RGP A 10— M RE DI T AR P R Py i 0 5 I 4 D e (1358 2
TEFE I AR) o R AR I 8 AR 5t (4 CPU TS

R

o WIRAE )RR A A S N 2R B CR R I T CPUT AR VR, T HE BLTR] 5 A LA
OB121J33).

e {ES7-300 I(CPU318F&41), HAEFEOBTFIOB100 [ml i J& 5 - 58 3 & N v, 7F3L & 0B
Hp e I g BB E B






